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Sage 50 Accounts credit control

Credit control is an essential part of any
business. Setting up a good credit control
system helps you to manage your cash
flow and avoid late payments and bad
debts.

The Credit Control option links closely with
Cash Flow, updating your cash flow
forecast with any promised payments and
amounts paid.

This guide describes some summary Best
Practice recommendations, and the new
credit control functionality available in this
version of Sage 50 Accounts.

Topics covered include ageing
transactions and aged balances, the new
Credit Control features, including the Diary
module, the Chase Debt and Manage
Payments chase views, and the improved
Customer and Supplier Dashboards.

Credit Analysis, Disputes, Bad Debt Write
Off and Reporting are all covered.

Finally, Cash flow forecasting is reviewed,
in relation to credit control.
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Managing credit control

Cash is King!

Good credit control with both your customers and suppliers improves your cash flow,
which is essential for your business to succeed, and your reputation in business.

Why is this?
s Cash is the lifeblood of any business

= Profitability is the aim but liquidity keeps the business engine running

= Paying late puts strain on supplier relationships and harms future business
reputation

By reporting on the money you are owed, money you owe and the age of the debts, you
are able to reduce late payments. This keeps money coming into your business, helping
it to grow.

Sage 50 Accounts' Credit Control facilities bring together all of the tools you need to
actively manage your outstanding debtor and creditor balances. The features cover all
aspects of credit control, from viewing transaction histories and aged balances for your
accounts, recording contacts for customers and suppliers and making payments,
through to disputing items, handling bad debts and writing off invoices.

The Credit Control facility links closely with Cash Flow, updating your cash flow forecast
with any amounts paid. Good credit control improves your cash flow, which is essential
for your business to succeed.

In this document you will find best practice for how to set payment deadlines for your
customers, how to charge your customers for late payment of bills and how to write off
bad debts.

All of these activities will enable you to keep tight control on your business and feel in
control of your incomings and outgoings. This document also explains how Sage 50
Accounts can provide you with appropriate letters to send to late-paying customers.
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Best practice recommendations

From the numerous customer contacts and discussions with Sage personnel, the following best
practice recormmendations have been compiled to assist you in implementing an effective credit
control system:

Create and publicise a policy for prompt payment of bills - ensure all staff are aware of it
Agree payment terms at the beginning of all contracts

Reinforce and emphasize payment terms throughout

Treat Credit Control as an important job every week

Offer as many ways of getting paid as you can - be clear as to whom cheques must be
paid, and give your bank details to accept BACS payments. Accept online card payments.

Monitor your payment system regularly for timely payment of invoices.

Check your Credit Control Dashboard / Chase Debt / Manage Payments / Diary Todo List
windows weekly

Resolve disputes quickly
Invoice accurately, clearly and promptly
Don’t be afraid to ask for payment - in full or in part - what can they pay?
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Ageing transactions in Sage 50 Accounts

Ageing in Sage 50 Accounts deals with the length of time that your customers have to pay you
and the length of time you have to pay your suppliers. Sage 50 Accounts has methods for
setting your deadlines for payment. These are:

= Calendar monthly ageing
= Period ageing
= Start Period Ageing on the first day of the month after Transaction Date

You can only use one of these options for customers and suppliers - that is, you can have one
scheme for your customers and a different one for your suppliers. You can set the type of ageing
by selecting Customers > Customer Defaults, or Suppliers > Supplier Defaults, clicking the
Ageing tab and selecting the type of aged setup that you require.

However, you can still change the number of days a customer has to pay you, in the individual
customer record.

Calendar monthly ageing
Use this option to set up ageing on a calendar basis. This means that all of a month's
transactions will be classed as outstanding on the first day of the following month.

For example: An invoice was sent out to a customer on the 15th January 2011, and was
recorded into Sage 50 Accounts on the same day.

The following table shows the calendar ageing periods.

Note: Because you can change the program date in Sage 50 Accounts and because you can
specify date ranges for your analyses, the first aged option is shown as Future.

For example, if you change your program date to the 31st December 2010 and then run your
aged analysis, the invoice shows up as Future, that is, it has not yet aged.

Date you run the Aged option Period the transaction shows in

Prior to 31 December 2010 (inclusive) Future

1 January 2010 to 31 January 2011 Current

1 February 2010 to 28 February 2011 Period 1

1 March 2010 to 31 March 2011 Period 2

1 April 2010 to 30 April 2011 Period 3

1 May 2011 onwards Period 4
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Period ageing

Use this option to set time limits based on the number of days that payment is overdue. Sage
50 Accounts sets these periods as 30, 60, 90 and 120 days but you can set any number of
days you require. For example: An invoice was sent out to a customer on the 15th January
2011, and was recorded into Sage 50 Accounts on the same day. The following table shows
the ageing period.

Note: For an explanation of Future, see the previous table.

Date you run the Aged option Period the transaction shows in

Prior to 14 January 2011 (inclusive) Future

15 January 2011 to 13 February 2011 Current

14 February 2011 to 14 March 2011 Period 1

15 March 2011 to 13 April 2011 Period 2
14 April 2011 to 13 May 2011 Period 3
14 May 2011 onwards Period 4

Start period ageing on the first day of month after transaction date

Use this option to set up ageing from the first day of the month following the transaction date -
that is, the date that you record the invoice on your Sage 50 Accounts system. For example, an
invoice was sent out to a customer on the 15th January 2011, and was recorded into Sage 50
Accounts on the same day.

The following table shows the ageing period in which the transaction is found if the Aged option
is run for a selection of dates.

Date you run the Aged option Period the transaction shows in

Prior to 14 January 2011 (inclusive) Future

15 January 2011 to 29 February 2011 | Current

1 March 2011 to 30 March 2011 Period 1
31 March 2011 to 29 April 2011 Period 2
30 April 2011 to 29 May 2011 Period 3

30 May 2011 onwards Period 4
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To set up your customers' aged balance defaults

1.

5.

Select Settings > Customer Defaults.
The Customer Defaults window appears.

From the Customer Defaults window, click the Ageing tab.
The Ageing information appears.

e

| Record " Statements . Ageing . Discount |

Ageing Type
() Calendar Maonthly Ageing
O Perind Ageing
Aged Period 1 Days
Aged Period 2 Days
Aged Period 3 119 Days

Aged Period 4 Days plus

Defaults

[ Include future totals in balance

Select the type of ageing you require.

If you want to include transactions that are dated after the date of the report when you use
the Aged option on the Customer toolbar, select the Include Future Totals in Balance check
box. For example, you may want to use this option if a customer has not paid an

outstanding invoice, and you want to see if they are ordering goods in the coming months.

In this way, you can put a hold on selling them more goods or services until they have
settled their outstanding invoices.

To exclude these future transactions, clear this check box.

To save your entries and exit click OK. To exit without saving, click Cancel.

Note: You can set up your Supplier Aged Balance Defaults in the same way by selecting
Suppliers > Supplier Defaults and clicking the Ageing tab.
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Producing a retrospective aged balance report

A retrospective aged report allows you to look back in time to see the aged balances as they
were on a particular date. You would do this, for example, if you wanted to have a look at a
particular customer's payment history.

To produce a retrospective aged report, from the Customer or Supplier window, open the
Reports window and double-click the Aged Debtors/Creditors Reports folder. Select the report
you want to produce, choose the output you require and click Generate Report. The Criteria
window appears. Enter a date range and select the Exc. Later Payments check box. To
generate the report, click OK.

Note: By selecting the Exclude Later Payments check box, all transactions paid after the
selected date range appear as outstanding on the report.

Checking aged balances

As part of your weekly or monthly activities you will probably produce your aged analysis reports
and compare them - that is, reconcile them, with the balances in your debtors and creditors
control accounts. For an explanation of debtors and creditors control accounts, refer to the
accompanying User Guide pdf > Chapter 5 > Setting Up Records > Control Accounts.

This lets you chase any outstanding debts from your customers. You can also check that these
control account balances agree with the transactions appearing on the aged balances reports.
In this way you can check whether your nominal ledger agrees with your customer and supplier
ledgers. If they do not agree then choose File > Maintenance and click Check Data. This checks
that the balances on the Customers ledger (sales ledger) agree with the balances on the debtors
control account (in the nominal ledger) and also checks the balances on the Suppliers ledger
(purchase ledger) agree with the balances on the creditors control account (in the nominal
ledger). If they do not agree you will get a warning.

If warnings are reported that relate to your debtors and creditors control account, refer to Why
data warnings appear when checking data in your debtors and creditors control accounts on
page 7.

If no data warnings appear, but they still don't agree, see Why your debtors and creditors
control accounts disagree even though no data warnings appear on page 8.

Why data warnings appear when checking datain your debtors and creditors
control accounts

= You have posted journal entries directly to the Debtors/Creditor Control accounts.

If there is a valid reason for posting the journals, make a note of it and inform your
accountant at the end of the year.

If the journal was posted by mistake, you should reverse the journal. For further information
about how to reverse journal entries, refer to the accompanying User Guide pdf >
Chapter 6 > Company Tasks > Reversing Nominal Journals.



Sage 50 Accounts Credit Control

After you have entered the customers' and suppliers' opening balances, you did not clear
these values from the trial balance before you entered the opening trial balance from your
accountant.

To correct this, clear the trial balance generated by Sage 50 Accounts from your customer
and supplier opening balances. For further information about how to do this, refer to the
accompanying pdf - Opening Balances.

You have entered your customer's and supplier's opening balances and cleared down the
debtors/creditors control accounts but you have not yet entered your opening trial balance
from your accountant.

It is normal to see these warnings if you have not entered your opening trial balance. When
you have entered the trial balance, these warnings should disappear.

You have previously fixed errors using Check Data.

This may have happened because Check Data was unable to fix the errors completely. If
this has happened you should restore a backup which was taken before these errors
occurred and re-enter your data.

If you have a backup which was taken before the errors were fixed by Check Data, contact
Sage Technical Support who may be able to help you to correct these errors over the
phone. Take a backup of your current data and send it to Sage Technical Support who may
be able to correct it for you.

Remember, if you send your data to Sage Technical Support, you must not enter any
transactions into Sage 50 Accounts until your data is returned to you. Please contact
Support prior to sending in your data. For contact details, refer to the accompanying User
Guide pdf > Chapter 1 > Welcome to Sage 50 Accounts > About Sage Support.

Why your debtors and creditors control accounts disagree even though no
data warnings appear

You have posted a correcting journal entry to the control account with an incorrect date.
To correct this, post a reversing journal. For further information about how to post a
reversing journal, refer to the accompanying User Guide pdf > Chapter 6 > Company Tasks
> Recording a Journal Entry > Reversing Nominal Journals.

An invoice dated outside the date range you specify was paid by a transaction within the
date range. To find out if this has happened, contact Sage Technical Support.

If these suggestions do not solve the problem, contact Sage Technical Support.

Setting credit controls for customers

After you have decided on a method of ageing your debts, it is important to enter the credit

control details within each customer's record. This can minimise the debt they can run up,
encourage payment by offering them a settlement discount as well as allowing you to keep
notes on any credit issues.
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Note: You can also record credit control details in your supplier records to remind you of the
terms you have agreed with your suppliers.

To enter your credit control details

1. Open the Customers module, then, if appropriate, use the view selector to switch to the
Customers view.

2. From the Customers window, select the customer or customers you require, then click
Record.

3. Click the Credit Control tab.
The Credit Control information appears, displaying the selected customer's credit control

details.
CEErmrma =)

Detsis | Defaults | Credit Contral | Sales | Orders | Projects | Graphs | Activity ||m|| Communications | Memo |

Terms Credit Review
Credit Limit A/C Opened
Settlement Due Days Last Credit Review
Sett. Discount Mext Credit Feview 04/02/202 |
Payment Due Days Application Date
Average Time to Pay Days Date Received
Trading Terms Text Memo:
Credit Ref. TS3803 =
Buresau ljl Trade references checked out OK. -

Pazsed credit check ieview.

Priority Customer O Good potential.
Credit Position Good I:l
Account stats |D Open Dl
DUNS Mumber [ ]

Restrictions
Can charge credit [ Restrict mailing —
Terms agieed

[ Save ] [ Discard l [ Delete l Mew Order ] [ New Invoice ] [ MNew Project Close

4.  Enter the following information:

Credit Limit If you want to set a limit on the amount of credit a customer
is allowed, you can enter the limit here.
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Settlement Due Days

You can give your customers a discount for early payment. If
payment is received within the number of days you enter
here, your customer qualifies for a discount.

Sett. Discount

If you want to offer this customer an early settlement
discount, enter the percentage discount in this box.

Payment Due

Enter the number of days in which the payment is due for
outstanding invoices. This information is used to help you to
keep track of overdue invoices.

Average Time to Pay

This box updates automatically as invoices and receipts
against them are posted to the account. You can over type
this with an estimated average value and this is taken into
account when the next calculation is made.

Trading Terms Text Enter up to thirty characters of text, for example 'sixty days'.
This can be printed on your invoices, statements and other
stationery if required.

Credit Ref. Enter the customer's credit reference here, if you have

obtained one from a credit control agency.

Sage 50 Accounts uses this information in conjunction with
the Internet Resources you set up to help you to check on a
customer's credit status. When you click the Hotlink button
at the right of the Credit Ref. box, Sage 50 Accounts
launches your Internet browser and loads the credit bureau's
website, according to the settings you enter in Internet
Resources for the bureau in use.

Use Settings > Internet Resources to set up the Credit
Checking URL, the path to the website, so that it
automatically searches for the credit reference in the Credit
Ref. box.

For more information about Internet Resources, refer to the
accompanying User Guide pdf > Chapter 12 > Support
Tools > Working with Internet Resources.
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Bureau

Select the credit bureau you want to use for this customer
from the drop-down list. Your default credit bureau appears
here automatically.

You can set up your credit bureau details in Internet
Resources. For more details, refer to the accompanying User
Guide pdf > Chapter 12 > Support Tools > Working with
Internet Resources.

Credit Position

Select the customer's current credit status from the
drop-down list.

If you use Sage 50 Accounts' Credit Control features to send
reminder letters to your customers, when they have overdue
balances on their accounts, this status changes according to
the settings you enter in the Configuration Editor.

For more information, refer to the accompanying User Guide
pdf > Chapter 3 > The Configuration Editor.

Account Status

Select the status you want. If a status is red, it puts the
account on hold.

DUNS Number

The DUNS Number (Data Universal Numbering System) is a
nine digit number, used to identify a business.

Use of this numbering system to identify a business is to
ensure compatibility with Zanzibar, the UK Government
e-purchasing portal.

Every e-order and e-invoice that passes through Zanzibar
must include a DUNS number.

Priority Customer

Select this check box if the customer has sufficient status to
your business, as to be regarded as a Priority Customer.

When you select this check box, the optional Priority column
in the Chase Debt window will be appended with a 'V, to
signify the priority status of the customer, with regard to
treatment and chasing.

Can Charge Credit

If you want to use the Credit Charges Wizard to apply
interest charges if this customer doesn't pay their bill on
time, select this check box.

11
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Restrict Mailing

You may want to exclude the selected customer from
mailings. For example, you can restrict them from all mailings
concerning overdue accounts. If you select this check box,
the customer is excluded when you print letters.

Terms Agreed

If you have agreed credit terms with this customer, select this
check box.

Account On Hold

If you want to place an account on hold, select this check
box. You might want to do this if you have not yet agreed
credit terms.

A/C Opened

Enter the date when you opened this customer's account.
The length of time a customer has been trading with you
may influence your decisions concerning credit terms.

Last Credit Review

Enter the date when you last reviewed this customer's credit
details.

Next Credit Review

Enter the date when you next want to review the current
credit terms. For example, you may want to review credit
terms on a six monthly basis.

If you change the next credit review date, the software will
query whether you want to add an entry in the Diary tasks
list. To add the task, click Yes. To cancel the confirmation,
click No.

Application Date

Enter the date the customer applied for credit here.

Date Received

Enter the date you received the credit application here.

5. If you want to keep additional notes on the credit agreement you have with the selected
customer, position the cursor in the Memo box and type your comments.

6. To save the details click Save or to clear any data you entered and start again, click

Discard.

7. To exit the customer record and return to the Customers window, click Close.
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Credit control features

In this version of Sage 50 Accounts, the credit control features for both Customers and
Suppliers have been updated. Central to your credit control is a new Diary module, clearly visible
on the Navigation Bar:

——
Diary

In your Diary module, you can create and manage credit control events and reminders. You can
view the diary in two ways - a Calendar Diary format, and as a Todo list.

— @
Diary Toda List
Your Diary data is fully integrated with Microsoft® Outlook, enabling you to:
- export Diary events to Microsoft® Outlook
- import Microsoft® Outlook appointments into your Diary
- export your Diary contacts to Microsoft® Outlook

New Chase windows have been developed for both the Customers and Suppliers modules, and
these are accessed from the Chase Debt and Manage Payments links in the respective Tasks
panes of those modules, and also from the Links pane of the Diary module.

% Chase Deht & Manage Payments

The Customers module Chase window is called Chase Debt, while the Suppliers module Chase
window is called Manage Payments.

These chase windows are also accessible from the Links pane of the Diary module.

The Customers and Suppliers Dashboard views have been updated to provide you with
at-a-glance summary data covering:

= Who'’s got my money? / Who do | have to pay?
= My overdue invoices

= Promised Payments

= Aged Debt

= Today’s Diary Events - for the current user

= Disputes

13
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The Diary module
The Credit Control Diary module makes it easy for you to manage your time and priorities,
leaving you feeling organised and in control.

To Diary views are available - a Calendar Diary format, and a Todo list, each selected from the
Diary window toolbar.

Diary =
o - -
Dap work Wesk  week Month Diary

[ include Completed

Bank Recancilia... Office Job MANAGER No 24/06/20... 24/06/20... No 3 T S
Statement Fiun  Office Job MAMAGER No 24/06/20... 2/06/20... Mo ARToW T s
Supplier papment .. Office Job MAMAGER No 24/06/20... 24/06/20... Mo oo o
Day  WorkWesk ek Month
24 June -
¥ Bank Reconciliation (Office) |
3¢ Statement Run (Office) I <J May 2011 4
¥ Supplier payment run (Office) %
= 2 45678
00 9101112131415
I 161718 19 20 21 22
01” 232425262728 29
3031
= = June 2011
02 MTWTFSS
e 12345
03® 678 9101112
1314151617 18 19
04” 2021222324252
27 28 29 30
00
05 July 2011
—_— MTWTFSS
06 % ) 123
456780910
07" 111212141516 17
181920 212223 24
- < +® - BrIBEIR
I August 2011
09® MTWTFSS
10 8 91011121314
1516171819 20 21
ol 222324252627 28
11 293031 1 4
12°
1300 o

| close |

Use the Diary or Todo List views for day-to-day planning - they display all of your important
business activities, such as follow ups from contacts, follow ups for promised payments, due
supplier payments, when letters / statements have been sent, and outstanding tasks and
deadlines in a single window, using a familiar calendar or To Do list layout.
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How can it help?

Using your Diary module enables you to:

Avoid missed due dates

By always being aware of those must-do chase tasks and deadlines, you'll avoid missing
your key tasks completion dates.

You will also avoid giving the wrong signals to your debtors.
Synchronise your credit control diary with Microsoft® Outlook

When you've set up your diary, you can integrate it with Microsoft® Outlook. Import
Appointments and export diary events and Contacts to and from Outlook - thus saving you
even more time.

Take responsibility for your own business activities

You don't need to rely on your accountant, or your manager to tell you when something
needs to be done - the diary is there to remind you.

Understand your business priorities over time

Use a combination of automatic events and reminders, together with those you set up
manually, to gain a clear picture of your activities over the coming day, week, working week
or month.

Ensure that you don't miss important events or deadlines

Use automatic and manual reminders to make sure you don't miss appointments, or to
remind you to pay a supplier or follow up a quote.

Recognise event types at a glance

You can categorise your events using colour-coded event types. In addition, you can
customise the Diary to suit the way your business works by defining your own event types.

15
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Diary - manually create a task or event

1.

4.
5.

Open the Diary module.

Your Diary module appears.

Choose your preferred Diary view, using the toolbar options provided.

Day Work Week Week tdonth

Double-click the diary day required. Alternatively, right-click the diary day, then choose Add
New Event, or from the Tasks pane, click New Event.

% Mew Event

The Event window appears.

Subject: | | |

Location: | |:|| Type: | [ none D| E]
I

Involves contact:

(=) customer () supplier

AfC: ljl Name: Contact: D|
[
Start Date: | 24/06/2011 [#] all day event?
End Date: |24/06/2011
I
[ Reminder: | 15 minutes Completed [ Assigned to: | MANAGER =]
Note:
[ Recurrence ] | Save | [ Cancel ]

Enter the event details in the boxes provided - see the table overleaf for details.

To create your new event record, click Save. Alternatively, to cancel your event creation,
click Cancel.
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You can enter the following event details:

Subject Enter the subject description of the new event here. You can use up
to sixty characters maximum. This is a mandatory entry box.
Location Enter the location of the event here. You can use up to sixty

characters maximum. You diary retains a list of the last ten locations
used. Choose any of these from the drop-down list provided, or

enter a new location.

Involves Contact

Select the Involves Contact option buttons for Customer or Supplier,

as appropriate.

Select from the A/C drop-down list, a customer or supplier account
reference, as required. Similarly, select a specific Contact name.
Alternatively, enter a new name in the entry box provided.

Type

From the pre-defined drop-down list of event types, choose the
event type that most closely matches your event. Each event type
has an unique colour coding to denote the event type in the Diary
View. You can choose from:

O More

O Appoinkment
O Meeting

O Job

O Delivery

O Reminder

O Phone Call

O Personal

O Mote

O User Defined 1
[ User Defined 2

Please refer to the section Diary - to create user defined event

types on page 21.

To customise your event type colours, use the Tools menu >
Options > Colours tab, then click the colour block, adjacent to

Diary Event.

The Colours window appears, where you can modify the colours
associated with specific event types.

17
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All day event?

Select this check box to denote the event as an all-day event.
When this is done, your saved all-day diary event is denoted by the
event description being shown at the top of the day chosen.

| 12 March |

Management Meeting

Start Date Choose the start date for the event. If necessary, use the Calendar
button to select a different day.
Next, select the hour-minute start time using the controls provided,
as required.
Note: This time entry section will not appear if the event as being
defined as an All Day event?

End Date Choose the end date for the event. If necessary, use the Calendar

button to select a different day.

Next, select the hour-minute end time using the controls provided,
as required.

Note: This time entry section will not appear if the event as been
defined as an All Day event?
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Reminder To set a reminder in order to inform the user of the imminent event,
select the Reminder check box, then choose the Reminder period
from the drop-down list provided.

The Reminder periods options available include:

1 minutes

5 minutes

10 minutes

15 minutes

30 minutes

1 hour
Any task or event created with a reminder setting, appears in the
Diary view with a characteristic alarm reminder symbol, adjacent to
the event / task description.

;IL‘:';:-
When the Reminder moment is triggered, a Reminders window
appears, informing you of the event or task, and prompting you to
open, snooze or dismiss the item.

s o
0 reminders are selected
M-eetiné I.;lli'ﬂ’1 Digby Dolomites to check outstandin. .. Z;fl minute{s}
Click Snooze to be reminded again in:
15 minutes
Completed Select this check box, when the task / event is considered

completed. The event is then listed in the Todo List with a
Completed column status of Yes.

19
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Notes

Enter any notes relating to this event. You can enter up to two
hundred and fifty six characters maximum.

As a faster alternative, click the diary event in the Calendar grid and
enter your notes directly into the day panel.

Assigned to

Selecting this drop-down list enables the event or task to be
assigned to a user:

Assigned to: | MANAGER D

Sam Smith
John Jones

When the software is first opened, the default user is MANAGER.

To add users, you must first have Access Rights switched on in
your Company Preferences, then follow the Create a New User
procedure.

Each user can view their own assigned tasks and events. Only the
MANAGER is able to view all tasks. The MANAGER is able to
reassign an event / task to another user.

In the case of a Recurring event / task, the MANAGER can reassign
a Recurring series to another user but not a single occurrence of
that series. For more information about this, please refer to topic
Diary - reassign an event on page 27.

Recurrence

To create a recurring event, click Recurrence.
The Appointment Recurrence window appears.

Select the various times and check boxes to create your recurring
event. For detailed information about the Event Recurrence window
procedure, please refer to Diary - manually create a recurring event
on page 22.

Your saved event is appears in the Diary view, colour coded, according to the event label

assigned.

11:00 2% Meet Jim Jones of Jim Jones Joinery (Client Premises)

Any task or event created with a reminder setting, appears in the Diary view with a characteristic
alarm reminder symbol, adjacent to the event / task description.
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When the Reminder moment is triggered, a Reminders window appears, informing you of the
event or task, and prompting you to open, snooze or dismiss the item. To edit an existing event
that appears in either the Diary or Todo List view, double-click on the event.

The Event window appears, displaying all event details, ready for amendment.
You have successfully created a diary task / event.

Diary - to create user defined event types

1. Open the Diary module.
The Credit Control Diary appears.
Choose your preferred Diary period view, using the options provided.

3. Double-click the diary day required. Alternatively, right-click the diary day, then choose Add
New Event.

The Event window appears.

4. Enterthe event details in the boxes provided, as described in Diary - manually create a task
or event on page 16.

5. Adjacent to the Type entry box, click the button.

(-]

The User-defined Types window appears.

User-defined T
ser-defined Types

Enter the names of the two user defined types:

User Defined 1

User Defined 2

QK Cancel
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6. Inthe Type 1 entry box, enter a description for your user defined event or task, thirty
characters maximum. If required, create a second user defined event in the Type 2 entry
box, again, thirty characters maximum.

F B

User-defined Types A

Enter the names of the two user defined types:

] |Custc:mer Budget Meeting |

1 |Cu5tomer Final Chase Meeting |

| oK || Cancel |

7. To save your user defined event types, and return to the Event window, click OK.
Alternatively, to close the User-defined Types window without saving, click Cancel.

Your user defined event types now appear in the Type drop-down list, from where you can
select them.

Type: | [ MNone |:|

O Appaintment

[ Meeting

O Job

[ Delivery

[ reminder

[ Phone Call

[ Personal

O Mote

O customer Budget Meeting

[ customer Final Chase Meeting

You have successfully created an user defined diary event type.

Diary - manually create a recurring event

In this example, the task or event concerned already exists. You wish to convert this single
occurrence into a recurring occurrence. To create new task or event, please refer to Diary -
manually create a task or event on page 16.

1. Open the Diary module.
The Credit Control Diary appears.
2. From the Diary toolbar, click Todo List.

&

Todo List
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A Todo list of the events for the current period appears.

Select your preferred Diary view, in this instance, typically the Week or Month View.

Day  Work'wWesk  Week
Double-click the single task or event instance that you wish to convert to a recurring
occurrence.

The Event window appears.
To change the event recurrence status of this event, click Recurrence.
The Appointment Recurrence window appears.

Appointment time

Recurrence pattern

Dail
O ¥ Recur every week(z) on:

Weekl
© wee Y | Monday Tuesday F Wednesday O Thursday

O Monthly

[DFriday [saturday [sunday
] Yearly
Range of recurrence

03/05/2011 @Nﬂﬂ"ddate
O et s

| OK | [ Cancel ]

The recurrence parameters in this window have been pre-populated, both with the existing
single instance parameters and some default recurrence settings. Amend these, as
required.

Enter the event recurrence details in the boxes provided - see the table below for details.

To create your new recurring event record, click OK. Alternatively, to cancel your recurring
event creation, click Cancel.

When you click OK, your event recurrence settings are summarised in the Event window.
To save your recurring event settings and return to the Diary View, click Save. Alternatively,

to cancel your recurring event creation, click Cancel. To delete the event completely, click
Delete.
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You can enter the following recurring event details:

Appointment Choose your Start and End times for your event using the time
time drop-down lists provided.
The Duration will appear automatically, based on the Start / End
times set.
Recurrence Choose one of the four recurrence patterns:
pattern

Daily

(@ Every |1 day(s)
O workDays

Choose either to have the event recur every XXXXX days, where
you enter XXXXX, within the range 01 - 99999 days, or occurs on
every work day.

Weekly
Recur every |1 week(s) on:
O Monday Tuesday O Wednesday O Thursday
[Friday [ Saturday [ sunday

Enter the weeks recurrence interval, within the range 01 - 9999,
then select the appropriate day(s) check boxes required.

Monthly

@Day‘ 3 of every | 1 month(s)

O the |First Monday of every |1 month(s)

Choose either to have the event recur on every XX day, where XX is
within the range 1st to 31st day of a month, of every YY month,
where YY is within the range 01 to 9999. Alternatively, to recur on a
particular instance of a particular day, of every XX month, where XX
is in the range 1 - 9999. The range of choice of a particular instance
of a particular day, is illustrated overleaf.
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Recurrence
pattern -
continued

9299 | month(s)

Yearly
@ Every |MEY |:||| 3 |
O The |First |:|||MOI'1day |:|| of |I""Iag-I |:||

Choose either to have the event recur on a particular calendar
month and day, where the month is within the range January to
December, and the day is within the range 01 - 31, depending upon
the month chosen; Or, to recur on a particular day of a particular
month.

The range of choice of a particular day of a particular month, is
illustrated by the following:

@ Every |I'~J'IE.|5-I

O The

May |:|

January
February
March

EE“

June

July
August
September
October
MNovember
December
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Range of Select the Start of the recurring event by using the date controls
recurrence provided. Choose an end date for the recurring event, from one of
three options:

No end date

Choose this option and the recurring event will be recorded as
being held indefinitely.

End after X occurrences

Enter the number of times that the event will be held, whereby XX is
a number, within the range 01 - 99999999.

End by a selected DD/MM/YYYY date

Use the date controls provided to select an end date for the
recurring event. The date format that appears will depend upon the
Country and Time/Date Regional Settings set.

Remove Where a recurring event has been created, and you wish to remove
recurrence the recurrence, click Remove recurrence to revert to a single event
instance, as defined during the event creation.

If you choose to Save your recurring event settings, the Recurring Event Series window closes,
and you are returned to the Todo List. To return to the Diary view, from the Diary toolbar, click
Diary.

Your recurring event is denoted by a Recurring symbol, next to every instance of the event.

31 March

If you subsequently modify the Start / End / Duration of one occurrence in the series, then save
this change, the Recurring symbol for that specific occurrence in the series will be changed.

You have successfully created a recurring task or event in your Diary module.
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Diary - reassign an event

In this example, a recurring event has already been created. As the MANAGER, you wish to
re-assign this event to another user.

Note: It is not possible to reassign a single occurrence of a recurring series to another user. The
Assign to drop-down list is disabled, in the case of a single occurrence event.

1. Open the Diary module.
The Credit Control Diary appears.

2. Locate the event in the ToDo List.

10 ]
11 ]

3. Double-click on the recurring event.

A message appears, advising that the event is recurring, and prompting you to choose to
open the occurrence or the series.

-
Cpen Recurring item ‘ u

"Management Meeting” is a recurring
appointment. Do you want to open
only this occurrence or the series?

@[bmﬂisoca.rrm.
D[bmlhesa'im.

ok || cancel |

4. Choose the Open the series option, then click OK.
The Event window appears.

5. Using the Assigned to drop-down list, choose another user to whom you wish to reassign

the event.

Assigned to: |MANAGER |:|
MAMAGER
Sam Smith
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6. To save the event modification, click Save.
The event will now appear in the Todo List of the user John.

Note: Such reassignment of events in a recurring series may result in the creation of a duplicate
event. In such an instance, the user may need subsequently, to delete the duplicate event.

Diary - mark an event / task as completed

In this example, the task or event concerned already exists. The event has taken place, and you
wish to mark the event as completed.

1. Open the Diary module.
The Diary module appears.

2. From the Diary toolbar, click Todo List.
The Todo list of the events for the current period appears.

3. Select your preferred Diary view, in this instance, typically the Week or Month View.

4. Double-click the single task or event instance that you wish to mark as completed.
The Event window appears.

5. Select the Completed check box.
Completed

6. To save the event properties and return to the Todo List, click Save.
Your modified event is now listed with a Completed status of Yes.

You have successfully marked your event /task as Completed in your Diary module.

In your Todo List, to include completed tasks, select the check boxes at the top of the module
window.

Inzlude Completed

Diary - manually delete an event

1. Open the Diary module.
The Credit Control Diary appears.
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From the Diary toolbar, click Todo List.

&

Todo List

A Todo List of the events for the current period appears.

Select your preferred Diary period view.

B 5 5 &

Day Wark ek ek

Select the task or event that you want to delete.

To delete the Event, right-click on the event, then from the context menu that appears, click
Delete.

The event is removed from the To-do List, and also from the Diary View.

You have successfully deleted your selected task or event from the Diary module.

Diary - view outstanding tasks

1.

Open the Diary module.
The Credit Control Diary appears.
From the Diary toolbar, click Todo List.

&

Todo List

A Todo list of the events for the current period appears.
Select your preferred Diary period view.

Your Todo list changes to reflect the period chosen. At this point, you may choose to
modify the appearance of your list using the configurable columns controls.

To include completed tasks or earlier, incomplete tasks, select the check boxes at the top
of the module window.

To print your To-do list click Print List. To edit or view a To-do list item in detail, double-click
on the item.

You have your successfully reviewed your outstanding tasks.

Diary - import / export contacts and appointments

1.

Open the Diary module.
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The Credit Control Diary appears.

2. Toimport / export Appointments and Contacts using Microsoft® Outlook, from the file
menu choose Office Integration > Microsoft® Outlook Import / Export Wizard.

Alternatively, from the Tasks pane of the Diary module, click Import/Export.
{% Import/Ewport

The Welcome window of the Sage 50 Calendar Import / Export Wizard appears.

Window 1 - welcome

Select Action

Select Action Select the action to

® Import Dutlook Diary Events
Select Options
O Export Diary Events to Duthook

O Export Contacts bo Outlook

Option 1 - import Outlook diary events

1. Choose Import Outlook Appointments to update your Credit Control Diary with your
Microsoft® Outlook appointments.

Note: Microsoft® Outlook 2000 or later must be installed in order to complete the wizard
successfully.

2. To continue, click Next.
The Options window appears.
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Select Options

o Select Action Copy Diary Events

o1/01/2010
o Select Options From
To nAz2mo

MOTE: If the date range specified contains an instance of a recuring
event all occurrences in the series will be copied.

Use the From and To Date Calendar drop-down buttons to choose a date range for your
Microsoft® Outlook import action.

To continue, click Import.

Your software proceeds with the import / export of your appointments / contacts, as
defined in the wizard, the wizard closes and you are returned to the Diary window.

Note: Any imported Microsoft® Outlook appointments appear in your Diary view with an
event label of None. Similarly, any exported Diary events from Sage 50 Accounts, appear
in Microsoft® Outlook, again with an appointment/event label of None.

Option 2: export diary events to Outlook

1.

Choose Export Diary Events to Outlook to update your Microsoft® Outlook Calendar with
those events already defined in your Credit Control Diary.

Note: Microsoft® Outlook 2000 or later must be installed in order to complete the wizard
successfully.

To continue, click Next.
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The Options window appears.

Select Options

o Select Action Copy Diary Events

o140 /2011
o Select Options From
To Az

MOTE: If the date range specified containg an instance of a recurning
event all occurences in the senes will be copied.

Use the From and To Date Calendar drop-down buttons to choose a date range for your
Copy Diary Events action.
To continue, click Export.

Your software exports your selected Diary Events and you are returned to the Diary
window.

Note: Any exported Credit Control Diary Events appear in Microsoft® Outlook with an
event label of None.

Option 3: export contacts to Outlook

1.

Choose Export Contacts to Outlook to update your Microsoft® Outlook Contacts with your
Sage 50 Accounts Customers and Suppliers Contacts list.

Note: Microsoft® Outlook 2000 or later must be installed in order to complete the wizard
successfully.

To continue, click Next.
The Options window appears.
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Select Options

Select Action Export Contacts 7
@ Bath

O Sales Ledger

O Purchase Ledger

Select Options

Select Dutlook folder to export

| ailbow - Snee, Roger\Contacts

Change Folder 2

3. Select the Both, Sales or Purchase Ledgers options to define those Contacts folders that
you wish to export into the Microsoft® Outlook Contacts directory.If appropriate, click the
Change Folder button to change your Outlook folder settings.

4. To continue, click Export.

Your software proceeds with the export of your contacts, as defined in the wizard, the wizard
closes and you are returned to the Diary window.

Note: If problems are encountered during the export, the software returns you to the Options
Window 2. Click Change Folder to load the Outlook folders and modify the folder structure.
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The credit control chase views

The chase views of Sage 50 Accounts credit control are accessible from within the Customers
and Suppliers modules, as well as from the Diary module. Each Chase view displays information
relating to the specific module selected.

The Chase Debt window is accessed from the Tasks Pane of the Customers module.
&I Chaze Debt

It can also be accessed from the Links pane of the Diary module. In both cases, the Chase Debt
window appears.

The Manage Payments window is accessed from the Tasks Pane of the Suppliers module.
&I Manage Payments

It can also be accessed from the Links pane of the Diary module. In both cases, the Manage
Payments window appears.
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Chase debt

The Chase Debt window displays a list of accounts with a summary of their current credit
position. The list displays information from the customer record, including the outstanding and
overdue balances, and the age of the oldest debit.

You can also see details of promised payment amounts, account statuses and credit positions
and the dates of any follow-up action you need to take.

Chase Deb (All Records) #,

a & m w a o B &
Record Activity Aged Disputs Charges Write off Analysis Letters Commurication  Feports Cash Flow Statement
Inciude invaices due within the ne: :U :day[s] Show: | gl
410001 A1 Design Services Jim Thamas 01742 876 234 0.00 000 1000.00
|ABS001 ABS Garages Ltd Mike Hall 0191 254 5303 o.on 253331 4000.00
|BBSO01 Buobsz Buiding Suppli... Susan Livingstore (1983 567 123 o.on 430877 2000.00
BRIOM Fred Briant Fred Briant 408 78787878 0.00 0.00 n.oo
BROOO Brorson Ine: Paul Guy 0o 214 2488324 0.00 0.00 4000.00
BUSOO! Business Exhibitions  Stephen Kiszow 017684 30707 -100.00 2066.62 4000.00
|CASHOM Cash and Credit Car 0.00 0.00 n.oo
| CE5001 County Golf Supplies Jeff walker 91 385 6432 0.00 2181.79 3000.00
Corom Compton Packaging  Sean Moris M9 121 3276 0.00 134364 4000.00
|DgTO01 Johnson Design & B... Peter Quigley 91 234 567 0.00 0.00 2000.00
|FGLOM F G Landscape & D... David Bradford (ME03 354564 0.00 11260.26 1000.00
| GRADDT Graham Electonics  Clint Peddie 0141 373 2822 0.00 4143.03 4000.00
HaU0m Hausser GMBH Alistair Leadbetter 00 49537 3443324 o.oo 1975.16 4000.00
|J5s001 John Smith Studios  Johin Smith 327 617 542 0.oo gr2.07 1000.00
| KINDm Kinghorn & French  Jaohin Bell (91 676 5656 739835 7398.35 6000.00
MACo01 tacolm Hall Assaci. Siobhan ‘winter 1244 343433 o.on B327.16 4000.00
IBOOT Mikes Insurance Ser. Mike Bradford 01754 234 B35 o.on 359716 1000.00
:MILDD1 Mile Rnad Health T Tracy Smithson 1981 674 234 -414 63 2307 84 2000.00
rMORO0 Morley Solicitors: John Bampton (1783 B56 556 -1375.00 39267 4000.00
PATO01 Patterson & Graham .. Simon Billington 0987 678 234 0.00 51524 1000.00
PICOO1 Picture Frame Ltd ~ Ahmed Roumani 01249 265 9874 BE7.78 31156 5000.00
ROEOO Robertson Joinery  Stephen Baker a1 789 2323 0.00 455020 8000.00
|SDEOM S D Enterprises Jane Scott 0191 937 9226 4700.00 5539.68 5000.00
|SHOOD1 The Show Lodge  Lesley Walton 21 323 0245 0.00 T148.07 2500.00
STEOD1 Stevenson & Smith  Jonathon Sapers 01244 453 232 0.00 1562.75 4000.00
STEDD2 Steven Stephenson  Steven Young 051 977 2276 0.00 0.00 0.oo
STUOM Edward Stuart Edward Stuart 0191 8329 2340 234125 2341.25 0.oo
Swia0ol Swian Leisure Centie John Blair 91 567 2245 1662 1698.83 4000.00
W00 The Wideo Rental C.. June Whitshouse  DB72 224 BE7S o.oo 204166 2000.00
Youom Peter Young Peter Young 08976 656 878 oo 2106.84 0.0o
| Search | Swap | | Clear | Brint List | | Close

You can change the information that the Chase Debt window displays using the Show:
drop-down list.

From the list, you can select:
= All Customers

= Outstanding Debtors

= Overdue

= Promised
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Disputes

= On Hold

= Unallocated

= Over Credit Limit

Choose the option you require, according to the type of accounts you want to view.

Further filtering of the customer list can be achieved by adjusting the Include invoices due within
the next XX day(s) entry box, where XX is the number of days selected.

Include invaoices due within the next| 0 day(z]

All the data columns displayed are configurable using your Configurable Columns control of
right-clicking on the column heading and selecting from the context menu that appears. The
Chase Debt window list can be further edited using the Search function in the window.

The Chase Debt and Manage Payments window lists are comprised of the following data

columns:

A/C This column displays the customer / supplier account code,
defined during record creation. Every customer / supplier with a
debtor / creditor history appears in the list, and the list is default
sorted in order by this code. This column appears by default.

Name The name of the customer is shown in this column, taken from the

Customer Record. This column appears by default.

Contact Name

This entry is taken from the Contact name entry of the Customer /
Supplier Record. This column appears by default.

Telephone

This telephone number entry is taken from the Customer / Supplier
Record contact information. This column appears by default.

Overdue

This column shows for each customer / supplier listed, the total
amount of sales / purchases that have not been paid within the
respective settlement period. This column appears by default.

Note: It is important to remember that invoices are aged, while
credit notes (CR/PR), payments on account (SA/PA), and sales /
purchase receipts (SP/PR) transactions are due immediately.

Balance

This current Balance entry is the total outstanding balance. This
column appears by default.
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Telephone 2

This telephone number entry is taken from the Customer / Supplier
Record contact information. This is an optional column and does
not appear by default.

Email

This email address entry is taken from the Customer / Supplier
Record Email Settings information. This is an optional column and
does not appear by default.

Credit Limit

This column displays the credit limit for each customer / supplier
listed, taken from Customer / Supplier Record. This column
appears by default.

Disputed

This column indicates whether an invoice is in dispute, and where
this the case, it is denoted by a symbol d being present in the
specific customer / supplier row. This column appears by default.

Payment
Method

This column displays the method of payment with the customer /
supplier. This column appears by default.

Promised
Payment

This column indicates whether a payment has been promised with
the customer / supplier. Where this is the case, a single letter Y is
visible, otherwise the entry is blank. This column appears by
default.

Unallocated

This column displays any unallocated amount of money received /
sent from / to the customer / supplier. This is an optional column
and does not appear by default. For more information about
posting unallocated monies, as payments on account, please refer
to the Help (F1) file topic Payments on Account.

Follow Up

If a follow up event has been created and logged against a
customer or supplier, the due date of that follow up appears in this
column. This column appears by default.

Each Age Period

This optional column shows the customer / supplier balance at
each aged period:

= Current

= Thirty days
= Sixty days
= Ninety days
= Older
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Account Status

This column indicates the current status of the customer / supplier
account. This is taken from the Customer / Supplier Record and
can optionally be displayed as:

= Open

= See Notes

s Closed (On Hold)

= Liquidation (On Hold)

= Expired Credit Limit (On Hold)

s Exceeded Credit Limit (On Hold)

= Bad Debt (On Hold)

= Solicitors (On Hold)

= New

= Cashonly

= Prospect

= Cash on Collection - ONLY
Where the account is On Hold, the Customer / Supplier entry in the

Chase Debt / Manage Payments list appears in red. This is an
optional column and does not appear by default.

Last Payment

This column displays the last payment from / to each customer /
supplier listed, and the date of that payment. This is an optional
column and does not appear by default.

Oldest Debt (in
days)

The amount and date of the oldest debt, for every customer /
supplier listed in the Chase Debt or Manage Payments window,
appears in this column. This is an optional column and does not
appear by default.

Credit Position

The current credit position with each customer / supplier listed,
appears in this column. This is taken from the Customer / Supplier
Record and can optionally be displayed as:

=  Good
= Reminder
= Warning
= Legal
This is an optional column and will not appear by default.
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Priority This column displays the assessed priority of this customer /
supplier -Y, with regard to the relative importance to your company.
This is taken from the Priority Customer / Supplier check box
condition in the Customer / Supplier Record.

This priority status may be defined in terms of proportion of
business that you receive / give from this customer / supplier, or
their prestigious position in your industry or market. This is an
optional column and does not appear by default.

The Chase Debt and Manage Payments window toolbars give easy access to key credit control
functions:

Record Choose a customer / supplier in the Chase Debt / Manage
Payments window list, then click the Record button and the Details
t% tab of the chosen Customer / Supplier Record appears. For more
Fiecord details about the Customer / Supplier Record, please refer to the
Help (F1) topics - To Enter your Customer / Supplier Record Details.
Activity Choose a customer / supplier in the Chase Debt / Manage
Payments window lists, then click the Activity button and the
Q:,':D’ Activity window for that customer / supplier appears. For more
Activity details about the Activity window, please refer to the Help (F1)
topics - To View Customer / Supplier Transaction Activity.
Aged Choose a customer / supplier in the Chase Debt / Manage
Payments window lists, then click the Aged button and the Aged
iui Balances Date Defaults window appears.
Aged

In the Aged Balance Report Date box, enter the date you wish to
use to calculate the aged balances. If you only want to include
payments up to a particular date, enter the date you require in the
Include Payments Up To box.

Click OK.

The Aged Balances window appears. For more information about
this window, press F1 to view the Help topic - To View Customer /
Supplier Aged Balances.
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Dispute

o

Dizpute

(Accounts Plus
and Professional
only)

Choose a customer / supplier in the Chase Debt / Manage
Payments window lists, where the Dispute column entry for that
customer / supplier is showing the - d - Dispute indicator, then click
the Dispute button. The Disputed Items window appears.

For more information about this window, press F1 to view the Help
topics - To mark a customer invoice / supplier transaction as
disputed.

Charges Before you can apply credit charges, you must set up your finance
- rates. Once you have set your finance rates - Settings >
= Configuration... > Terms tab > Customer Finance Rates, choose a
Charges customer in the Chase Debt window list, then click the Charges
button.
The Credit Charges wizard appears. For more information about
the Credit Charges Wizard, press F1 to view the Help topic - The
Credit Charges Wizard.
Write off Choose a customer / supplier in the Chase Debt / Manage
: Payments window lists, then click the Write off button. The Write
ﬁ Off, Refunds and Returns Wizard appears. For more details about
‘wirite aff this wizard, press F1 to view the Help topic - The Write Off, Refunds
and Returns Wizard.
Analysis Choose a customer in the Chase Debt window list, then click
Analysis. The Days Sales Analysis window appears, showing the
@ Days Sales Outstanding information. For more details about the
Analysis Days Sales Analysis window, press F1 to view the Help topic - To
View your Days Sales Outstanding Information.
Letters Choose a customer / supplier in the Chase Debt / Manage
- Payments window lists, then click Letters. The Customer /
L‘\;,'/ Suppliers Letters window appears. For more details about the
Letters Letters window, press F1 to view the Help topics - To Print

Customer / Supplier Letters.

Communication

=]

Communication

Choose a customer / supplier in the Chase Debt / Manage
Payments window lists, then click the Communication button. The
Communication tab of the chosen Customer / Supplier Record
appears. For more details about the Communication tab, press F1
to view the Help topic - Recording Communications Details.
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Reports

B

Reports

From the Chase Debt / Manage Payments windows, choose the
Customers / Suppliers required, then click Reports. The Customer /
Suppliers Reports window appears.

Double-click the folder for the type of report that you want to run,
for example Aged Debtors Reports. The selected folder opens to
display the available reports.

Click the report you want to run.

Select how you want to display your report from the drop-down list
options: Printer, Preview, or File or Email.

Click Generate Report.

Depending on which report you selected, the Criteria window may
appear. This includes only those criteria that are appropriate to the
report selected. From here you can select to limit the number of
transactions you preview.

If you select a value in the space provided, only the number of
transactions specified will be displayed. If you leave the box display
as the default value 0, all of the transactions will be displayed.

To accept the criteria details and run the report, click OK.

Cash Flow

|5,

Cash Flow

Choose a customer / supplier in the Chase Debt / Manage
Payments window lists, then click Cash Flow.

The Cash Flow window appears.

For more details about the Cash Flow window, press F1 to view the
topic - To Use the Cash Flow Option.

Suggest
Payments

Suggest Payment

To view a prioritised list of all the suppliers with overdue or
outstanding balances, click Suggest Payments.

The Suggested Payments window appears, from where you can
choose to prioritise your overdue supplier, and make payments.
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Manage payments

The Manage Payments window is accessed from the Tasks Pane of the Suppliers module

&, M anage Payments

It can also be accessed from the Links pane of the Diary module.

& & om0 A& @ & E

Fiecard Activity Aged Dispute Witeoff  Suggest Payment Letters Communizatian [ Cash Flaw

Show: N[ |

ABAC Abacus Express 0113 2435765 0.00 000

| ABCPROMO ABC PROMOTIO., 0113 2506125 0.00 ooo
| ABRAKASL CORPORATEE.. 020 82366373 0.00 ooo
ACTEBIS ACTEBIS DISTR... ANDY ARNOLD 01753 830241 0.00 ooo
JACTIONCO INSITE SAMANTHA 0800 333333 0.00 oon
| ADIMPO EURDFACTOR I A/CMO. UKo, Telephone 0193, 0.00 oon
|&DT 4DT FIRE & SEC. DEMISE Kay 0113297 1084 0.00 0.00
ADVENTDA ADVENT DATA BLEXIA 01484 408300 0.00 0oo
| AIDPACK AIDPACK 08005424428 SA. 0.0o oo
| ALEA ALBA TYRES LT 0113 244 4462 0.0o oo
|ALPHA ALPHA BUSINE PETER PETER 017538 000 0.0
AMCHOR UK KEYHOLDIN... 0870 8508050 0.00 ooo
|AQUARIUS AQUARIUS wia,. 0113 287 5627 0.00 0.o0
|ARGOS ARGOS 0.00 ooo
B&HDIST B&HDISTRIBU... 01442 828188 0.00 0o
| BANNERBR BANNERERIDG WAYNE OR DA 0870 g701220 0.00 000
| BANSAL BANSAL PRINT. 0113 244 2265 0.00 000
BARKER BARKER 01423 8BBEEE 0.00 0.00
BARRAGEN BARR AGENCY 0.00 oo
| BASF BASFLTD 0.00 oo
| BATES&CO BATES & COMP. 0113 2424677 0.0o oo
BESTLTD BESTLTD 0.00 ooo
BETA BETA DISTRIBU. STEPH 0207 531 2833 181678 181678
| BGASACC BRITISH GAS A.. 0.00 ooo
| BGASELEC BRITISH GAS 0245607 3357 0.00 ooo
| Search | Swap | | Clear | |PrintList | Close

The Manage Payments window displays a list of supplier accounts with a summary of their
current payment position. The list displays information from the supplier record, including
overdue balances and the age of the oldest debt. You can also see details of promised payment
amounts, account statuses and credit positions and the dates of any follow-up action you need
to take.

You can change the information that the Manage Payments window displays using the Show:
drop-down list.
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From the list, you can select:

All

Outstanding
Overdue
Promised
Disputes

On Hold
Unallocated
Over Credit Limit

Choose the option you require, according to the type of accounts you want to view.

To ensure that you are viewing the most up to date supplier state, click Refresh.

All the data columns displayed are configurable using your Configurable Columns control of
right-clicking on the column heading and selecting from the context menu that appears.

The Manage Payments window list can be further edited using the Search function in the
window.

For details on the data columns in the The Manage Payments window list, please refer to the

section Chase debt on page 35.

The Manage Payments window toolbar provides you with a number of credit control functions.
For more information about these toolbar buttons, please refer to the section Chase debt on
page 35.
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Suggested payments

Sage 50 Accounts Suggested Payments feature helps you to keep track of your creditors and
decide which of your supplier debts you should pay first.

When you use Suggested Payments, a prioritised list of the suppliers that you should pay
appears. The accounts of those suppliers set as Priority Suppliers are placed first in the list with
the highest outstanding balance first. The accounts of the remaining suppliers follow, placed in
order of the amount outstanding.

When you click Suggest, Sage 50 Accounts suggests a value for you to pay each supplier,
starting at the top of the list. If you re-sort the list before you click Suggest, for example to
display the outstanding amounts in date order, Sage 50 Accounts still suggests payments for
your suppliers in the order that they appear.

When you choose to make a payment from the Suggested Payments list, Sage 50 Accounts
displays the Supplier Payments window. The supplier's account, invoice and payment
information appears in the window automatically, ready for you to check and save the payment.

If you require, you can modify the suggested payment amount for any supplier. You can also
print the list of suggested payments using the Print List button.

When you make a payment to a supplier using Suggested Payments, Sage 50 Accounts resets
the supplier's credit position to Good, and reduces any promised payments by the amount you

pay.

To view a list of suggested supplier payments

1. Open the Suppliers module, then from the Tasks pane, click Manage Payments.
The Manage Payments window appears.

2. From the toolbar, click Suggest Payments.
The Suggested Payments window appears.
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e .
Available Funds
Funds for Payment Paid 000 Remsining 000 SiltoPay: 500.00
Bank Account
EBank 4/C: 1200 El Bark Current Account Balance: 479337 Min Limit 0.oo
SMITHS... Smiths Utilities 500.00 500.00 2000.00 o.oo
£ 1l >
Suggest ] [Make Payment.. ] [ Clear ] [ Print List

The Suggested Payments window displays a prioritised list of all the suppliers with overdue
or outstanding balances.

In the Funds for payment box, enter the value of the bank funds that are available for
payment.

Alternatively, you can leave the Funds for payment box blank, and allow Sage 50 Accounts
to enter the balance available in the bank account when you click Suggest. For more
details, refer to step 5.

In the Bank Account area of the window, select the bank account you want to use for the
payments from the Bank A/C drop-down list.

The bank account's name, current balance and minimum limit appear in the remaining
boxes in the Bank Account section of the window.

Click Suggest.

Note: If the Funds for payment box is blank, Sage 50 Accounts checks the balance and
minimum limit of the bank account you are using, to see whether funds are available in the
account.

If funds are available in the account, Sage 50 Accounts displays the message:

You have not entered a value for the funds available for payments. £xxxxx is available in the
selected bank account. Do you wish to use this value so the system can suggest which
payments to make?

To use the suggested amount, click Yes. To cancel and enter your own value, click No.
If there are no funds available in the account, Sage 50 Accounts displays the message:
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You have not entered a value for the funds available for payments. Please enter a value for
the funds for payment before continuing.

Click OK and enter a value in the Funds for payment box, or select a bank account with
sufficient funds to make payments and repeat steps 3 and 4.

Sage 50 Accounts suggests a payment amount for each outstanding balance in the
Payment Amount column, using the funds available for payment, and indicates the reason
for suggesting the payment in the Reason column.

To amend the amount Sage 50 Accounts suggests for a payment, click into the Payment
Amount column on the line you want to change and type in the amount you want to pay
to that supplier. Alternatively, you can enter the amount using the Calculator button.

To discard the suggested amounts, for example if you want to re-enter your available funds
value or select a different bank account, click Clear.

The Payment Amount column clears, ready for you to make the changes you require and
request the suggested values again.

To print the list of suggested payments, click Print List.

To continue making a payment to a supplier, refer to the following section.

Alternatively, to return to the Manage Payments window without making any payments,
click Close.

To make a supplier payment

These instructions assume that you have already followed the steps in the previous section and
clicked Suggest to display the suggested payment in the Payment Amount column, or entered
your own payment amounts.

1.

From the Suggested Payments window, select the account to which you want to make a
payment.

Click Make Payment.

The Supplier Payment window appears, automatically displaying the supplier details and
payment amount.

Allocate the payment amount to the invoices you want to pay by entering the value you
want to pay in the Payment £ column.

Continue allocating payments until the value in the Analysis Total box is equal to the
amount of the suggested payment.

To save the payment details, click Save. Alternatively, to clear the data without saving, click
Discard.

To return to the Suggested Payments window and select another supplier to pay, click
Close.



Sage 50 Accounts credit control

The Suggested Payments window appears, displaying the value of any saved payments in
the Payment Made column.

The software:

= Reduces the value of any promised payment for the selected supplier by the amount
of the payment.

= Increases the value in the Paid box by the amount of the payment, showing the
amount that you have paid so far.

s Decreases the value in the Remaining box by the amount of the payment. This shows
the value of your Funds for payment remaining after making the payment.

= Reduces the value in the Still to Pay box by the amount of the payment, showing the
total remaining outstanding and overdue balance on your supplier accounts.

In addition, a message appears at the top of the list to inform you whether there are
sufficient funds remaining to make the rest of the suggested payments.

7. Continue in the same way to pay the suppliers you require.
8. To print the list of suggested payments and the payments made, click Print List.

9. To exit the Suggested Payments window, click Close.
The Manage Payments window appears.
You have successfully viewed your suggested payments and paid your suppliers.
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Dashboard view

Dashboard views are used in Sage 50 Accounts as a quick way of providing you with useful
information, in relation to the module you are currently working in.

The information displayed is up-to-date at the time the dashboard is first displayed. If you have
the window displayed for any length of time, you can click on the Refresh option to refresh it.

.
=

In both the Customers and Suppliers modules, the Dashboard View aims to give you an
at-a-glance barometer of your business credit state, using the following categories:

= Who's got my money? / Who do | have to pay pie chart?

= Aged Debt

= Today’s Diary Events - for the current user

= Promised Payments

Customer Dashboard (All Records) % Change View v X
Last updated: 04 May 2011 Time: 11:24 @ Update & print

Customer Cash Overview: £24381.06

) Aged Debt: £24381.06 Q)
Click on any section to display a breakdown by customer Click on the graph to display a breakdown by customer

25000
20000
15000
10000

5000

Future Current 30 Days 60 Days 90 Days Older

[ overdue: £19724.02
O Not Due: £4657.04

Customer List &

Today's Diary Events ﬂ Promised Payments: £0.00 u
Click on any event to display details Click on any figure to display breakdown by Customer

2000

Meet with CarodonRetail CARODON1

1000

0

This week Next week Future

Customer List &

The view selector allows you to change what is displayed in the Sage 50 Accounts work area.
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To access the Credit Control Dashboard View, click on the Change View button shown in the
top right-hand corner of the work area, then select the option you require from the drop-down
list that appears.

Change View = X

Customer Process
Customers

v Customer Dashboard

Who’s got my money? / Who do | have to pay? pie chart

Customer Cash Overview: £24381.06 :l:

Click on any section to display a breakdown by customer

[0 owverdue: £19724.02
@ wot Due: £4657.04

This pie chart presents graphically all monies owed to you / by you, broken down as:
= Not Due

= Disputed

= Overdue - total overdue less disputed

= Not-Allocated - unallocated SC, SP, SA

You can click on each portion of the pie chart to drill down into the data, firstly by customer /
supplier, to show the customer / supplier list responsible for that portion, showing the Customer
/ Supplier Reference and Value in base currency.
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Aged debt

Aged Debt: £24381.06
Click on the graph to display a breakdown by customer

25000
20000
15000
10000

5000

0

Future Current 30 Days 60 Days 90 Days Older

Customer List &
This mini-Aged Debt line graph depicts the total amounts for Current, One Month, Two Months,
Three Months and Older.

Click on each value in the line graph to drill-down into a list of those customers / suppliers
responsible for the Aged Debt total. Click again on a customer / supplier in the drill list to
drill-down into the transaction list for that customer / supplier.

Today’s diary events

Today's Diary Events
Click on any event to display details

Meet with CarodonRetail CARODON1

This section of the Dashboard displays a list of today’s events for the current user - taken from
the Calendar.
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Click on an event in the list to drill-down into the specific event record.

Promised payments

Promised Payments: £0.00
Click on any figure to display breakdown by Customer

2000

1500

1000

500

o
This week Next week Future

Customer List &

This bar chart section of the Dashboard displays the Promised Payment values for This Week,
Next Week and Future.

You can click on each portion of the bar chart to drill down into a list of promised payments,
listing by Customer / Supplier Ref, Invoice No, Value and Due Date.
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Recording communication details

Sage 50 Accounts provides you with the ability to keep a record of the communications you
have with your customers and suppliers. These records are stored as part of your customer and
supplier records, in the form of a Communications tab.

For example, when chasing debts by telephone, a summary of the conversation you have with
your customer can be entered. If your customer has promised that the cheque will be sent in
the post that day, your creation of the communication event can set a reminder in your Diary
module on a day in the future, to check that the cheque has actually arrived.

An event is created in the Diary module, based on the outcome of a communication. These
include - No Contact, Left Message, Contact Made, Call them back, They will call back,
Reminder letter sent / received, Warning letter sent / received, Legal letter sent / received, Other
letter sent / received, Promised Payment from / to customer / supplier, and Dispute.

Your chase letters are defined in your Configuration Editor - Credit Control tab, accessed from
Settings menu > Configuration. For more information about this, please refer to the
accompanying User Guide pdf document, accessed from Help menu > User Guide.

If a supplier has delivered the wrong order, you can record the conversation you have with them
and you can set a Follow Up, so that you can check that all of the remedial action has been
completed. You can also charge time for telephone calls made and generate service invoices to
bill for your time.

The figure below shows the Customer Record Communications tab:
[ totors ot S |

| Details | Defaults | CreditControl | Sales | Orders | Projects | Graphs | Activity | Bank | Communications | Memo

Account Status Open Outstanding A1EZE4  Dwerdue 1334.40
Credit Pozition Good Credit Limit 0.00 Pramised Payment 2000.00

Date Range

mEE [ e [pazaes [

04/05/2011 Telephone. made 4162.64 Payment Promised 2000.00 12/05/2011

< {1 >
[ mew || Edt |[ swp || cear | [ Delete |
[ Save ] [Dismrd ] [ Delete ] [Printust] [Newnrder] [Nawln\mice] [New iject]
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Note: Clicking Communication from the Suppliers Manage Payments window opens the
corresponding selected Supplier Record Communications tab.

The Communications tab displays summary information about the selected account in the
upper part of the window, where you can change the account or date range in use, if required.

The tab can be divided up into three distinct sections:

Communications tab - account summary

The following account details are summarised in the top half of the Communications tab:

Account Status

This read-only entry indicates the current status of the customer or
supplier account. The status can optionally be displayed as:

= Open

= See Notes

s Closed (On Hold)

= Liguidation (On Hold)

s Expired Credit Limit (On Hold)
s Exceeded Credit Limit (On Hold)
= Bad Debt (On Hold)

= Solicitors (On Hold)

= New

s Cashonly

= Prospect

= Cash on Collection - ONLY

Outstanding This read-only entry provides a money total of all orders
outstanding with the selected customer or supplier, both overdue
and not yet due.

Overdue This read-only entry provides a money total of all overdue payments

from the selected customer or to the selected supplier.
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Credit Position

The current credit position with the chosen customer or supplier,
appears in this read-only box. This position can optionally be
displayed as:

= Good

n Reminder

= Warning
= Legal
Credit Limit This Credit Limit read-only entry was set in the Customer or
Supplier Record during record creation.
Promised This read-only entry indicates the value of any payment promise
Payment that has been made to you by the customer, or by you to the

supplier.

Where this is the case, a single letter Y is visible, otherwise the entry
is blank.

Communications tab - date range

In the upper-middle section of the tab, the list of communication events for the selected
customer or supplier can be filtered using the Date Range From / To calendar buttons.

Date Range

Ta |31/12/2093

Communications tab - communication history

Occupying the main part of the tab, the communications history for the selected customer /
supplier is presented, with the following communications details available for display.

Note: Right-click a column header in the list to select the columns to be displayed.

Subject Enter the reason or purpose of the communication in this entry box.
Use up to thirty characters.

Contact Type The type of contact made, chosen from Telephone, Letter/Fax/
Email, Meeting, and whether the communication was made, sent or
received.

Date The program date appears here. You can change this if required.
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Contact The name of the contact stored on the customer record appears
here for you automatically.

If you speak to someone who is not your regular contact, you can
change the name here.

Our Contact The name of the person who made the call appears here. If this has
been entered incorrectly, you can change it here.

Completion This is the outcome of the contact made or received. The contact
Status outcome types include:

= No Contact

= Left Message

= Contact Made

= Call them back

= They will call back

= Reminder Letter sent / received
= Warning Letter sent / received
= Legal Letter sent / received

= Other Letter sent / received

= Payment Promised - Customer / sUpplier
= Dispute

Balance The current balance of the Customer or Supplier account is
displayed here.

Promised Any promised payment that has been agreed during the contact is
Payment recorded here.
Follow Up If any Follow Up date was recorded in the Customer / Supplier

Communications window during the communication, it is displayed
here in your date format.

Notes Any notes made in the Notes pane in the Customer / Supplier
Communications window, during or after the communication, are
presented here.

The buttons that appear at the bottom of the Communications tab help you to manage your
contact list. For details about using the New, Edit and Delete buttons, refer to the following
sections. The Print List button allows you to print the contacts that currently appear in the list.
To print the details of each communication in the list, click Print Details.
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To add or edit a communication

1.

From the Tasks pane of the respective module, select one of the following:
= Customers > Chase Debt

g, Chase Debt
= Suppliers > Manage Payments

& Manage Paymentz

From the respective Chase window that appears, select the account you want to record
contact information for.

Click Communication.

Communication

The Communications tab of the selected Customer or Supplier window appears,
displaying the list of contacts for the record you selected.

To add a new communication, click New. Alternatively, to amend an existing
communication, select the communication you want to amend, then click Edit.

The Customer / Supplier Communications History window appears, displaying the
Communication Detalls tab.

Note: By default, Sage 50 Accounts selects the Telephone option button and assigns a
contact type of "Telephone, made' for all new communications.

- ~
ey e
Communication Details Memo |
Communication Details Contact Details
O Telephore O Letter/Fax/Email (& Meeting Met A1 Garner =]
Subiect Discuss HDTY trends in 2013 Telephone 07973341124 =
Balance 3801.50 Streetl
Streetz
Date 01/10/2011 = B
Our Contact MANAGER ] County
Our Office =]
Communication Result
Outcome Contact Mads ] Nates:
ces down - slaw shift ta 30 preference
Follow Up [31107zm1 [] Time 03.00 =]
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Enter the contact details of your communication. For more information about the entries
on this tab, please refer to The communications history communication details tab on page
58.

In the case of Customer Communication, to generate an invoice for the communication,
click Invoice.

The Communication window appears, enabling you to enter the contact and posting
details you require for the invoice.

Note: For telephone communication, your software calculates the chargeable time using
the information in the Telephone Timer section of the window. For other contact types, or
if you did not use the timer to record the duration of a call, you must enter the chargeable
time manually.

In the Memo tab of this window you can enter memo narratives for the specific
communication, and add attachments, such as visit reports, letters or other information.

To save the communication details and return to the Communications tab, click Save.

To exit from the Communications tab and return to the Chase Debt or Manage Payments
window, click Close.
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The communications history communication details tab

Enter your Communication Details into the following sections of the window:

Communication Details

Use this section to record general information about the
communication, such as the contact type, subject, date, the
person making the contact, and a contact name. You can
record a communication for a telephone call, for letter, fax or
e-mail correspondence, or for a face-to-face meeting. The
entry boxes and drop-down lists that appear, depend upon
the contact type to be made.

Note: If you are amending an existing contact, you cannot
change the overall type of the contact. For example, you
cannot change a telephone contact into a letter, fax or e-mail
correspondence or a face-to-face meeting.

If you send or receive a letter, you can specify its type from
the Style drop-down list. These styles include Other,
Statement, L1-Reminder, L.2-Warning, L3-Legal. For
meetings, you can specify the location, selecting from Our
Office, Customer’s Office or Other.

Important Note: If you need to send a final demand letter to
a customer for payment, while you can send it by email, as
an attachment, you should keep copies of the letters and the
emails, to which they were attached.

If you are considering using recourse to the Courts, not only
must you have evidence of a Read Receipt from those
emails, you must take the additional precaution of sending
the final letter by recorded delivery post, to the registered
delivery address.

Contact Details

Enter the name of the person you spoke to and the address
details, if different to the Customer Record, in the entry
boxes provided.

If you are recording a telephone call, your software enters the
telephone number from the customer or supplier record into
the Telephone box. If you use the Windows telephone dialler
with your software, click the image to the right of the
telephone number to dial the number.
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Telephone Timer

Note: This section of the window only appears for Telephone
contacts.

If you want to record the duration of a telephone call, click
Start, when the call begins. The Start box shows the start
time of the conversation. The timer counts until you click
Stop at the end of the call. The Stop box displays the end
time of the conversation, and the Duration box shows the
length of the call in hours, minutes and seconds.

Note: If you generate an invoice for this contact using the
Invoice button, your software uses the Telephone Timer
information to calculate the chargeable time.

Communication Result

Use this area of the window to record the outcome of the
communication. From the drop-down list in the Outcome
box, you can specify, for example, whether you spoke to a
customer or left a message, whether you are sending a letter,
or that the customer made a promise of payment. You can
also specify a follow-up date and a new account status for
the account, if you require.

Note: If you set the Outcome to Send Reminder Letter, Send
Warning Letter or Send Legal Letter, your software sets the
New Account Status to the default for that letter type, as it
appears in the Credit Control tab of the Configuration Editor.
If this new status differs from the current account status, a
confirmation message appears to alert you to the change.

If a customer agrees to make a payment, or you agree to
send a payment to a supplier, select Payment Promised from
the Outcome drop-down list. Enter the amount of the
promised payment in the Promised Amount box, and the
date that it is due.

When you record promised payment details, the Customers
or Suppliers list in the Chase Debt or Manage Payments
window displays the promised amount against the relevant
account. The promised payment also appears in your Cash
Flow window.

Note: The promised payment recorded will be the most
recent one noted - that is, if a promised payment record
already exists, and you make note of another, updated or
revised promise, then it will be the revised payment promise
that is shown in the cash flow and Diary event records.
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The communications history customer / supplier memo tab

The Memo tab is provided so that more extensive notes, attachments and memoranda can be
recorded, regarding the communication made. You can add attachments, such as visit reports,
letters or other information. To save your memo narrative for the specific communication, click
Save. To save and generate your memo narrative, click Save and Generate.

What happens when a new or amended communication is saved?

Sage 50 Accounts stores the details of the communication in the Communications
tab.

An event is created in the Diary, based on the outcome of the communication. These
include - No Contact, Left Message, Contact Made, Call them back, They will call
back, Reminder letter sent / received, Warning letter sent / received, Legal letter sent
/ received, Other letter sent / received, Promised Payment from / to customer /
supplier, and Dispute.

Any promised payment information displays in the Chase Debt / Manage Payments
and Cash Flow windows. If promised payments already exist for this account, Sage
50 Accounts removes the original details from the Chase Debt / Manage Payments
and Cash Flow windows and posts a new entry for the updated details.

If the communication contains an amended account status in the customer / supplier
record, Sage 50 Accounts updates the record with the new status.

If the outcome of the communication is to send a letter or statement to a customer,
your software generates the correspondence. If the correspondence style is Other,
you can select a file to attach to the communication record

To exit from the Communications tab and return to the Chase Debt or Manage Payments
window, click Close.

You have successfully recorded your communication details.

To delete a communication

1.
2.

From the Communications tab, select the contact(s) that you want to delete.
Click Delete.

A confirmation message appears.

To confirm that you want to delete the contact(s), click Yes. Alternatively, to cancel without

deleting the record(s), click No.

To exit from the Communications tab and return to the Chase Debt or Manage Payments
window, click Close.
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Viewing transaction history and aged balances

The Activity and Aged facilities are available within both the Chase Debt and Manage Payments
windows.

& |l

Activity Aged

The Activity feature allows you to see the financial activity for a selected account. You can print
a copy of the activity information from the Activity window. This may be useful as a reference
during telephone conversations or for face-to-face meetings for example.

The Aged facilities, Aged Debt in the Chase Debt, Aged Credit in Manage Payments, enable you
to view a summary of the outstanding debt on an account, grouped by ageing period. From the
Aged Balances window, you can change the display so that you see the information in a detailed
or graphical format, and you can also print the summary and detailed aged balance information
directly.

To view customer or supplier transaction history

1. Select one of the following:

s Customers > Chase Debt

% Chase Debt
= Suppliers > Manage Payments

&I Manage Payments

2. From the respective Chase Debt / Manage Payment window that appears, select the
account you want to view the transaction history for.

3. Click Activity.

&

Activity
The Activity Date Range window appears.
4. Enter the transaction range, transaction type and date range information you require, and
click OK.

The Activity window appears, showing the transactions associated with the account you
selected, one transaction per line.

The window also displays the total amount that your customers owe, or that you owe to
your suppliers, grouped by age, in the boxes at the bottom of the window. For example,
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the total debt of a customer that is less than thirty days old, appears in the Current total
box.

5. To view another account's transactions, select the reference of the account you require
from the drop-down list in the A/C box at the top of the window.

6. To view a different range of transactions, click Range. Enter the transaction range,
transaction type and/or date range you require, and click OK.

7. To print a copy of the transactions in the list, click Print List.

8. To exit the Activity window, click Close.
The Credit Control window appears.

To view a customer or supplier aged balances

1. Select one of the following:

s Customers > Chase Debt

% Chaze Debt
= Suppliers > Manage Payments

&I Manage Payments

2. From the respective Chase window that appears, select the account you want to view
aged balances for.

3. Click Aged Debt or Aged Credit.

i

Aged
The Aged Balances Date Defaults window appears.

4. Enter the dates you require and click OK.

The Aged Balances window appears. The window shows the total of any outstanding
invoices for the customer or supplier, grouped by age.

Note: The Aged Balances window determines the ageing periods to use from the settings
you enter in Customer Defaults and Supplier Defaults. For further details about setting up
your ageing periods, see Producing a retrospective aged balance report on page 7.

5. To see the account's detailed aged balances, click Detailed.

The Detailed Aged Analysis window appears, displaying the individual transactions that
make up the aged totals.

6. To print the list of aged balances, click Print List.
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To view the aged balances in a graphical format, click the Graph tab. You can access the
graph from both the Aged Balances window and the Detailed Aged Analysis window.

To exit from the Aged Balances window, click Close.
The Chase Debt or Manage Payments window appears.
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Handling disputed transactions
(Accounts Plus and Accounts Professional only)
If a customer queries an invoice you have sent them, you can mark the invoice as disputed until

you come to an agreement. You can mark any invoice that is not fully paid as disputed. As soon
as the invoice query is settled you can remove the disputed flag.

Disputed transactions appear in your Sage 50 Accounts reports. Some reports display these
transactions as disputed by displaying a 'd"' alongside them.

If you do not want to show disputed items in your Sage 50 Accounts reports, you must set a
filter. For further information about how to do this, refer to your Report Designer User Guide.

Note: You can also mark invoices you have received from your supplier as disputed by choosing
the Dispute option from the Suppliers tab of the Credit Control window.

To mark an invoice as disputed

1. Select one of the following:

s Customers > Chase Debt

;%I Chaze Debt
= Suppliers > Manage Payments

&I Manage Payments

2. From the toolbar of the respective Chase window that appears, click Dispute.

L

Dizpute
The Disputed Iltems window appears.
From the A/C drop-down list, select the account you require.

Select the transaction you want to mark as disputed and click Dispute.

The Details window appears, prompting you to select a reason to explain why the item is
in dispute.

Note: You can set up or amend reason codes in the Configuration Editor. For more
information, refer to the accompanying User Guide pdf, Chapter 3, Setting Up Sage 50
Accounts, Configuration Editor.

5. Select the reason code you require, and click OK.

The transaction now displays 'd" in the 'Disputed?' column, and the reason for the dispute
in the 'Dispute Reason' column.
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Alternatively, to return to the list of transactions without marking the item as disputed, click
Cancel.

To record your changes, click Save. To exit without saving your changes, click Discard.

To return to the Chase Debt or Manage Payments window, click Close.
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Credit control reporting

Sage 50 Accounts comes with several reports to help you with credit control and debt chasing.

Aged debtors reports

The Aged Debtor Analysis (Detailed) report gives you the most detail about who owes you
money. We recommend that you use this report when you are chasing debts.

Date: 04/05/2011 Casa63Blanca Utilities Page: 1
Fime: 12:22:49 Aged Debtors Analysis (Detailed)

Date From: 01/01/1980 Customer From:

Date To: 01/12/2011 Customer To: LIITAITT
Include future Yes

Exclude later No

*% NOTE: All report values are shown in Base Currency, unless otherwise indicated **

A/C:  ACRODEM1 Name:  Acrodam Hotel Contact: Tel:

No  Type Date  Ref Datails Balance Futura Current Pariod 1 Pariod 2 Pariod 3 Older

75 ST ZB/06201127 3Zinch LCD HOTV 3,801.60 0.00 0.00 0.00 0.00 0.00 3,30L.60
Totals: 30160 .00 800 .00 .00 () 380160

Turnowver: 0.00

Credit Limite 5,000,00

A/C:  BELINDAL Name:  Selinda Entertanment Contact: Tel:

Mo Type Date Ref Details Balance Future Current Period 1 Period 2 Period 3 Older

99 S0 21/06/201139 Speclal Service 5.580.41 0.00 0.00 0.00 0.00 0.00 5,580.41

101 S 2B/06/201140 Special Service 5,580.41 0.00 0.00 0.00 0.00 0.00 5,580,41
Totals: 11,160.82 0.00 0.00 0.0 .00 [ 11,160.82

Turnowver: .00

Credit Limitf 5,000.00

A/C:  CARODON1 Name:  Caradon Retail Contact: Tel:

No  Type Date  Ref Details Balance Future Current Period 1 Period 2 Period 3 Older

62 SI 14/0B/201146 5D inch Flasma 667.20 0.00 0.00 0.00 0.00 000 867.20

63 ST ZB/0B201147 50 inch Plastma 667,20 0.00 0,00 0.00 0.00 0.00 667,20

132 SI 11/01/2012114 Cravitic Lifter 2B23.24 2,828.24 0.00 0.00 0.00 0.00 0.00
Tatals: 162,64 282829 3.00 0.00 [T ) 133440

Turnover: 2,356.87

Credit Limite 0.00

The report shows the following:

Balance | The Balance column lists the total sum each customer owes and the total owed
by all debtors from unpaid invoices, less any unused credits or payments on
account.

Future This shows you what financial transactions will happen in the future. The Future
column lists the total value of customer transactions - that is, invoices, receipts
or credit notes, dated in advance of the report date. A value will only appear in
this column if you have selected Include Future Transactions in the Criteria
window.
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Current Using the default ageing periods, the current column shows the total of each
customer's transactions that are less than thirty days old, or the ageing period
specified.

Periods | The software then categorises the transactions that are overdue into periods: 1,

2, 3 and Older.

There are two additional aged debtors reports available:
= The Aged Debtors Analysis (Summary) lists each customer and the balance they owe for
each period.

= The Aged Debtors Analysis (Contacts) lists each customer and the balance they owe for
each period as well as their contact detalils.

To run an aged debtors report

1. From the Chase Debt window, click Reports.

Select the Aged Debtors Reports folder.

3. Select the report you want to print, the type of output from the drop-down list, and then
click Generate Report.

The Criteria window appears.

4. Enter the following criteria:

Customer Ref If you want to run the reports for a specific customer range,

enter the customer references you require. If you want to run the
report for all of your customers, accept the defaults.

Report Date Enter the date you want to age the debts against.

Note: Enter the date that you want to age the debts against in
the To box. If a From date is entered and there are any
transactions outstanding prior to this date, they will show on the
report as a total brought forward figure.

Inc. Future Tran If you want to include transactions dated after the report date,

select this check box.
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Exc. Later Select this check box if you want to produce retrospective aged
Payments reports. This means that later payments will not be included so
that you can see how much your customer owed you on a
particular date.

For example, if you have an invoice dated in March but paid in
April and you run the aged report for March selecting the Exc.
Later Payments check box, the report will show the invoice as
outstanding as the payment will not be included in the report.

Other customer reports

The following reports can also help you improve your credit control:

Customer invoices due

This report lists all the outstanding invoices up to the current system date.

Customer invoices overdue

This report lists all outstanding invoices with reference to the Payment Due days that have been
set in the Customer Record and Credit Control tab.

The report looks at the invoice date, pay due days and report date in order to calculate whether
the invoice is overdue. You can use this report most effectively, where some customers are
allowed thirty days to pay and others only seven days, for example.

Customer invoices within settlement terms

This is a useful report to send to a customer to encourage them to pay early. To produce this
report, Sage 50 Accounts looks at the date of the sales invoice, calculates the date the
customer must pay to qualify for the discount, and the saving to be made if the payment is made
early.

Statements

Use statements to keep your customer informed of their balance with you. Statements can be
sent to customers at any time, and can be printed for a specific customer range or transaction
date range.

There are lots of different statement layouts that can be produced to suit your individual
requirements. You can choose to print statements that show each individual transaction or you
can choose to group transactions that have the same date and reference.

The software updates the communication history of each customer account, when a statement
is sent, if the user confirms that it is appropriate to do so.
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The address for the statement is taken from the communication settings, where the user has
selected the appropriate address for statements to be sent.

Note: These reports can be found on the Statements button, next to Reports.

Payment reminder letters

If your customers do not pay you after you have sent them their statement, you can use Sage
50 Accounts' Payment Reminder or Chase Letters. There are several different types of letters
provided, including:

= Oldest Debt - Current

= Oldest Debt - 30 Days

s Oldest Debt - 60 Days

= Oldest Debt - 90 Days

= Oldest Debt - Over 90 Days

Note: These can be obtained through the Chase Debt toolbar, by using the Letters button.

The software updates the communication history of each customer account, when a letter is
sent, if the user confirms that it is appropriate to do so.

The address for the letters is taken from the communication settings, where the user has
selected the appropriate address for chase letters to be sent.

Important: Chase letters can be sent by email output. However, it is vital that users not only
keep copies of the letter and email sent but also obtain a Read Receipt to show evidence of the
email and chase letter having been received. It is recommended that the third or final letter to
the customer be sent by recorded post to the registered office address.
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Charging your customers for late payments

Sage 50 Accounts includes a facility to enable you to apply credit charges to customers who
do not pay on time. By default, a payment is regarded as late if it is thirty days overdue. If you
want to apply different payment terms, you must enter the required number of days in the
Payment Due box in the Credit Control tab of the Customer Record.

Before you can apply any credit charges to your customers, you must set up the rates you want
to use. To do this, select Settings > Configuration, then choose the Terms tab to view the
Customer Finance Rates information. For details about how to set up your finance rates, refer
to the accompanying User Guide pdf > Chapter 3 > Setting Up Sage 50 Accounts >
Configuration Editor.

You can set the date the finance rate applies from, the base rate percentage and any additional
percentage rates that you want to apply. When you apply a finance charge rate to a transaction,
the first rate charged will also be applied to the invoice until it is paid. For example, if a payment
is overdue in March and again in April, the same finance rate will be applied for both months
until the payment is made. You cannot increase the finance rate for that invoice.

When you have entered your finance rates, use the Credit Charges Wizard to guide you through
the process of applying credit charges to overdue payments.

To run the Credit Charges wizard, click Charges from the toolbar of the Chase Debt window.

Charges

Alternatively, you can access the Credit Charges Wizard from the Customers window. Follow
the instructions in the wizard to apply the charges.
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Days sales analysis

Days Sales Analysis helps you to measure your company's debt collection performance by
calculating the average time it takes to collect your debts. You should use this feature at the end
of a sales period, for example at the end of each month as part of your Month End routine.

The Days Sales Analysis window is split into three tabs.

Use the Days Sales Outstanding tab to see whether your company is collecting its
receivables effectively. In the form of a graph, it shows how many days' worth of sales are
outstanding and not paid for at any given time.

The Days Sales Overdue tab indicates how well your customers are meeting their payment

terms. You can use this information to see if your customers are good payers, or if you
need to improve your debt collection processes.

The Details tab shows a list of days sales outstanding and overdue for each company that
falls within the period up to the current program date.

To find out how to use each section of the Days Sales Analysis feature, refer to the following
sections.

To view your days sales outstanding information

1.

Open the Customers module, then from the Tasks pane, click Chase Debt.
;&I Chaze Debt

The Chase Debt window can also be accessed from the Links pane of the Diary module.
The Chase Debt window appears, showing the Customers information.

From the toolbar, click Analysis.
E
Analysis

The Days Sales Analysis window appears, showing the Days Sales Outstanding
information.

7



72

Sage 50 Accounts Credit Control

The window displays the following details:

Company's Days Sales
Outstanding

Sage 50 Accounts calculates the company's Days Sales
Qutstanding value by taking the total outstanding balance
from all customers within the company and working out how
many days' worth of sales this value represents. The
resulting figure shows, on average, how long your customers
take to pay their invoices.

For example, your usual payment terms are thirty days and
Sage 50 Accounts shows a Company's Days Sales
Outstanding figure of sixty six. This indicates that, on
average, your customers' payments are thirty six days
overdue. Unauthorised credit can be costly, so you can now
take steps to reduce the amount of overdue debt.

If this figure rises month by month, your business is taking
longer to collect its debts and should take action to correct
this.

If the figure falls month by month, your company's collection
processes are improving, or your customers are becoming
better at paying on time.

Default Payment Terms

This box displays your company's default payment terms in
days. This is the number of days that you usually give your
customers to pay their invoices. Sage 50 Accounts reads
this information from the default you set up in the Terms tab
of the Configuration Editor. For more information about
setting up your terms, refer to the accompanying User Guide
pdf > Chapter 3 > Setting Up Sage 50 Accounts >
Configuration Editor > Terms tab.

You should use this value as a guide when analysing your
days sales outstanding information - if the Company's Days
Sales Outstanding figure is more than twice the Default
Payment Terms, then your company may not be collecting its
debts effectively and you may want to review your collection
processes.
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Graph The graph shown in the main part of the Days Sales
Outstanding window displays, for the whole company, the
number of customers that have outstanding balances on
their accounts. The graph shows the number of customers
that fall into each of your company's ageing periods.

Sage 50 Accounts reads the ageing periods, shown on the
X-axis of the graph, from your Customer Defaults, accessed
from Customers module > Customer Defaults in the Links
pane. You can amend the appearance of the graph to suit
your requirements. For details about manipulating graphs,
refer to the Sage 50 Accounts Help system.

To close the Days Sales Analysis window and return to the Credit Control window, click
Close.

Alternatively, to continue viewing your Days Sales Analysis information, click the Days Sales
Overdue tab. Refer to the following section for more details.

To view your days sales overdue information

1.

Open the Customers module, then from the Tasks pane, click Chase Debt.

Alternatively, open the diary module, then from the Links pane, click Chase Debt.
% Chasze Debt

The Chase Debt window appears, showing the Customers information.

From the Chase Debt toolbar, click Analysis.

@

Analyzis

The Days Sales Analysis window appears, showing the Days Sales Outstanding
information.

Click the Days Sales Overdue tab.
The Days Sales Overdue window appears.
The window shows the following information:
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Company's Days Sales
Overdue

Your Company's Days Sales Overdue figure shows, on
average, how many days overdue your customer balances
are at this point in time. Sage 50 Accounts takes the total of
the overdue balances for all customers within the company
and calculates how many days' worth of sales this value
represents.

If this value is very low, customers may either be very good
payers or their payment terms may be too generous. If the
value is significantly higher than your standard payment
terms, you may need to improve your debt collection
processes.

Default Payment Terms

This box displays your company's default payment terms in
days. This is the number of days that you usually give your
customers to pay their invoices.

Sage 50 Accounts reads this information from the default
you set up in the Terms tab of the Configuration Editor. For
more information about setting up your terms, refer to the
accompanying User Guide pdf > Chapter 3 > Setting Up
Sage 50 Accounts > Configuration Editor > Terms tab.

You should use this value as a guide when analysing your
Days Sales Overdue information. If the Company's Days
Sales Overdue figure is very low when compared with the
Default Payment Terms, then either your customers are very
good payers, or their payment terms are too generous.

However, if the Company's Days Sales Overdue figure is
significantly greater than the Default Payment Terms, then
your company may not be collecting its debts effectively and
you may want to review your collection processes.

Graph

The graph shown in the main part of the Days Sales Overdue
window displays, for the whole company, the number of
customers that have overdue balances on their accounts.
The graph shows the number of customers that fall into each
of your company's ageing periods. Sage 50 Accounts reads
the ageing periods, shown on the X-axis of the graph, from
your Customer Defaults (Customers > Customer Defaults).

You can amend the appearance of the graph to suit your
requirements. For details about manipulating graphs, refer to
the Sage 50 Accounts Help system.
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To close the Days Sales Analysis window and return to the Chase Debt window, click
Close.

Alternatively, to continue viewing your Days Sales Analysis information, click the Details tab.
Refer to the following section, To view your detailed days sales analysis on page 75, for
more details.

To view your detailed days sales analysis

1.

4.

Open the Customers module, then from the Tasks pane, click Chase Debt.
Alternatively, open the diary module, then from the Links pane, click Chase Debt.
% Chaze Dehbt

The Chase Debt window appears, showing the Customers information.

From the Chase Debt toolbar, click Analysis.

@

Analyzis

The Days Sales Analysis window appears, showing the Days Sales Outstanding
information.

Click the Details tab.
The Details window appears.
The window shows the following information:

Company's Days Sales | This box displays the value Sage 50 Accounts calculates for

Outstanding your company's Days Sales Outstanding analysis. For
details, see To view your days sales outstanding information
on page 71.

Company's Days Sales | This box shows the figure Sage 50 Accounts calculates for
Overdue your company's Days Sales Overdue analysis. For details,
see To view your days sales overdue information on page 73.

Default Payment Terms | This box displays your company's default payment terms in
days, as set up in the Terms tab of the Configuration Editor.

List The main list on the Details window shows a list of customer
accounts that have sales outstanding or overdue, at the
current date.

To print the list, click Print List at the bottom of the window. The list information outputs to
your chosen printer.
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5. To close the Days Sales Analysis window and return to the Credit Control window, click
Close.

You have now viewed your Days Sales Analysis information.
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Writing off bad debts

Sometimes you may want to write off outstanding transactions on an account, for example, if a
customer does not pay an invoice and the outstanding balance becomes a bad debt.

When you write off a transaction, the balance transfers to a bad debt control account, which
displays on the year's Profit and Loss report as an overhead. In addition, writing off a bad debt
reduces the debtors or creditors figure on the Balance Sheet.

When you write off a debt, you need to decide whether it meets the VAT Bad Debt Relief
conditions set by HM Revenue & Customs. You then need to check the balance on the account,
and post the necessary transactions.

Sage 50 Accounts offers you two ways to write off bad debts. The Write Off, Refund and
Returns procedure automates the write off procedure for you and posts the necessary
transactions to reduce the outstanding amount and balance your books. Alternatively, you can
process bad debts manually by posting the transactions you need to record the write off.

Note: The Write Off, Refund and Returns procedure does not account for VAT. If you need to
reclaim VAT when writing off transactions that meet the VAT Bad Debt Relief criteria, you must
post manual transactions to account for the VAT.

This section describes how to use the wizard to write off bad debts, and provides instructions
on how to perform write offs manually.

VAT bad debt relief

Note: VAT Bad Debt Relief only applies if you are using the standard VAT accounting scheme.
If your business operates under the VAT Cash Accounting scheme, you pay VAT only on the
money you actually receive from customers, so VAT Bad Debt Relief is not necessary.

For those users who operate the flat rate accounting scheme, please refer to HMRC Reference:
Notice 733 (March 2007) Section 14 - Flat Rate Scheme for small businesses, for guidance.

If your customers do not pay you for goods or services that you supply, you can claim relief from
the VAT on the bad debt, as long as you meet certain conditions specified by HM Revenue &
Customs. These conditions include the following:

= You must already have accounted for the VAT on the invoice and paid it to HM Revenue &
Customs.

= You must have written off the debt in your VAT accounts and transferred it into a separate
bad debt account.

= The debt must have remained unpaid for a period of six months from the payment due
date, or the date the supply was made, whichever is later.

Similarly, if you do not pay a supplier for goods or services they provide, they are entitled to claim
VAT Bad Debt Relief according to the same set of conditions. In this case, you are obliged to
repay the VAT portion of the bad debt.
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Note: For a full list of the conditions applying to VAT bad debt relief, and an explanation of the
conditions, see VAT Notice 700/18. You can obtain copies of VAT Notices from HM Revenue &
Customs, or download them from www.hmrc.gov.uk.

Writing off bad debts using the write off, refunds and returns procedure

The Write Off, Refund and Returns procedure automates the write off procedure for you and
posts the necessary transactions to reduce the outstanding amount and balance your books.

Note: You can only use the procedure to write off bad debts if your business operates under
the Standard VAT accounting scheme. If you use the VAT Cash Accounting scheme, you must
write off debts manually. For more details, refer to the Sage 50 Accounts Help system.

For those users who operate the flat rate accounting scheme, please refer to HMRC
Reference:Notice 733 (March 2007) Section 14 - Flat Rate Scheme for small businesses, for
guidance.

The Write Off, Refund and Returns procedure does not take VAT into account. If you need to
reclaim VAT for transactions that meet the VAT Bad Debit criteria, you can use the procedure but
you will then need to post manual transactions to account for the VAT element of the write off.
Alternatively, you can write off the debt manually using the instructions in Writing off bad debts
manually on page 80.

To write off a sales invoice using write off, refunds and returns procedure

Note: The following procedure describes how to use the Write Off, Refund and Returns
procedure to write off a bad debt invoice for a customer. If you want to write off a supplier
invoice, replace 'Chase Debt’ with ‘Manage Payments' in the steps below.

1. Open the Customers module, then from the Tasks pane, click Chase Debt.
Alternatively, open the diary module, then from the Links pane, click Chase Debt.
% Chaze Debt
The Chase Debt window appears, showing the Customers information.
2. From the Chase Debt toolbar, click Write Off.
)
Wiite off
The Write Off, Refund and Returns Wizard appears.

3. Select Write off Customer Transactions, then select the account that contains the
transaction(s) you want to write off, then click Next.

The list of outstanding transactions on the customer account appears.
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ot e T =

Process Data

o Select Action
O Process Data
@ Update Data
® FostData

Select the outstanding invoice tranzaction(z] from the list below that are to be written off o

Cancel

20 LOC.. 4001 03/05/2011 14 LeftH... 305.71
21 LOC.. 4001 17/05/2011 15 LeftH... 305.71
22 LOC.. 4000 31/05/2011 16 LeftH... 305.71
23 LOC.. 400 14/06/2011 17 LeftH... 305.71
24 LOC. 4001 28/06/2011 18 LeftH... 305.71
25 LOC. 4001 12/07/2010 19 Left-H... 30571
26 LOC.. 4000 26/07/2011 20 LeftH... 305.71
27 LOC.. 4001 09/08/2011 21 LeftH... 305.71
28 LOC. 4001 23/08/2010 0 22 Left-H... 305.71
29 LOC. 4001 08/09/2011 23 LeftH... 305.71
30 LOC.. 4001 20/09/2011 24 LeftH... 305.71
[ Back ] [ MNext ]

4. Select the invoice(s) you want to write off, then click Next to continue.

5. Enter the date and any additional reference you want to use for the write off and click Next

to continue.

6. Check the transaction summary that appears on the Post Data window, and click Post to

confirm the details and post the write off transactions.

Sage 50 Accounts posts a sales credit note to the customer's account using the bad debt write

off nominal code and the non-VATable tax code, usually T9.

The sales credit transaction:

= Credits the debtors control account for the total amount of the bad debt, including VAT;

= Debits the bad debts control account for the total amount of the bad debt, including VAT;

and

= Reduces the outstanding balance on the customer account by the total amount of the bad

debt.

Note: Because Sage 50 Accounts posts the sales credit note with a non-VATable tax code, your
next VAT Return does not pick up the transaction.
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Using the procedure to write off other debts

Using the procedure, you can post four types of write off:

= Customer or supplier accounts. Use this option if you want to write off an entire account,
for example if a customer or supplier stops trading.

s Customer or supplier transactions. Choose this option to write off individual transactions.

= Transactions below a specified value. Select this option if you want to write off small
amounts, for example, transactions under 50 pence (you may have a lot of very small
transactions which, for some reason, have not been paid and you want to clean up your
ledgers).

= Small Overpayments. Use this option to write off small customer or supplier overpayments
(again, if you want to clean up your ledgers).

To use the procedure, select whether you want to make amendments to the Sales ledger or
Purchase ledger. Next, select the type of write off you want to make and then follow the
on-screen instructions.

When you write off bad debts using the procedure, Sage 50 Accounts automatically generates
all the appropriate adjustments to the nominal ledger and the customer or supplier account.
However, VAT is not accounted for. If you need to reclaim or repay VAT, you must post
transactions to account for the VAT element of the write off. Read how to reclaim or repay VAT
in To reclaim VAT After writing off a sales invoice on page 81.

Writing off bad debts manually

Note: These instructions only apply if you are using UK Standard VAT Accounting. Under VAT
Cash Accounting you do not need to reclaim the VAT from bad debts as you only pay VAT on
the money you actually receive. However, you do need to post transactions to balance your
books (to reverse out the invoices or credit notes).

For those users who operate the flat rate accounting scheme, please refer to HMRC
Reference:Notice 733 (March 2007) Section 14 - Flat Rate Scheme for small businesses, for
guidance.

To post a bad debt sales credit and write off a sales invoice

In this example, there is an unpaid invoice of £120.00 on the customer account, Brown Ltd. You
want to write this balance off as a bad debt.

1. Select Customers > Batch Credit.

The Batch Customer Credits window appears.
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Enter the details in the Batch Customer Credits window, For example:

A/C Date Ref N/C Details |Net T/C VAT
BROWN |Write off |BADDBT |8100 Write off {120.00 [T9 0.00
date

2. To post the credit note click Save, or to exit without saving, click Discard and then click
Close.

Sage 50 Accounts posts the credit note, and the Batch Customer Credits window clears.

3. To return to the Customers window, click Close.
The Customers window appears.

You now need to allocate the credit to the invoice to clear the outstanding debt, for further
information about this, please refer to the Sage 50 Accounts Help System.

Posting the Credit Note has the following effect on the control accounts:
= Credits the debtors control account for the total amount of the bad debt, including

VAT;

n Debits the Bad Debt control account for the total amount of the bad debt, including
VAT and

= Reduces the outstanding balance on the customer’ account by the total amount of
the bad debt.

To reclaim VAT After writing off a sales invoice

If you post a write off transaction but need to reclaim the VAT you can achieve this by posting
ajournal.

If you need more information about the conditions that need to be satisfied before the VAT can
be recovered on a bad debt, please contact HM Revenue & Customs - www.hmrc.gov.uk.

In the following example, you wrote off an invoice with a balance of £120.00, and now need to
recover the £20.00 VAT element.

Note: The standard rate of VAT was increased to 20 per cent on 04 January 2011.

Note: This section assumes that you have posted the write off credit as described in To post a
bad debt sales credit and write off a sales invoice on page 80.

1. Select Company > New Journal.

The Nominal Ledger Journals window appears.
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2. Enter a date and reference for the journal, then enter the required information to reclaim
the VAT, for example:

N/C Name Details |[T/C Debit Credit
2201 Purchase |Baddebt |T1 20.00 0.00
Tax Relief
Control
Account
8100 Bad Bad T9 0.00 20.00
Debt Debt
Write Off |Relief

Note: the date used for this journal should satisfy HM Revenue & Customs’ rules for bad debt
relief.

3. Topost the journal, click Save, or if required, to exit without saving, click Discard then click
Close.
The journal is posted, and the Nominal Ledger Journals window appears.

You have now posted the journal to reclaim the VAT. As required by HM Revenue and Customs
this transaction updates box 4 of the VAT Return, VAT reclaimed in this period on purchases.
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Forecasting your cash flow

Have you ever asked yourself...
= Who can | afford to pay within the next few days?

= My customers owe me money, and | need to pay my supplier / staff. Which customers
should | chase up to pay their debts?

= How much cash will | have after | have made my payments?

The Cash Flow facility allows you to plan payments to your suppliers, expected incomes,
expected expenditure and variable payments such as wages and utility bills.

The Cash Flow facility looks at the customer and supplier credit control details that you have
entered, when you set up each customer record, and creates a list of outstanding transactions.

Any changes that you make to your Cash Flow will be remembered and recalled the next time
that you use the Cash Flow feature.

Note: The Cash Flow facility does not take settlement discounts into consideration.

To forecast your cash flow

1. From the Bank Accounts, Customers Chase Debt or Suppliers Manage Payments
windows, click Cash Flow.

Caszh Flow

2. The Cash Flow window appears.
e e

Date range: | Newt 7 days [ From [02/08/2011 []  Forecastupto: [08/10/2011 [] NOTE: All values displayed in GBP-—

Summary Bank Accounts
g ] A
Book Balance tor Bark Account(s) 4739.37 1200 Bank Current Account 4799.37 0oo
Reqgular Papments 0.o0 1210 Bank Deposit Account 0.00 ooo [ =
Forecast Payments 0.00 1220 Building Soci... 0.00 ooo [
Fegular Receipts 0.00 1230 Petty Cash 0.00 ooo[]
Forecast Receipts E11.42 1235 Cash Register 0.00 ooo [
Farecast Book Balance for Period 5410.79 1240 Company Credit Card 0.00 000 v

Al | Regular Payments | Forecast Payments | Regular Receipts | Forecast Receipts
E  oimiz2011 08/08/2011 LOCALPET Left-Handsd Snor 23 days 30671 0.oa 5105.08
S 15/11/2011 22/09/2011 LOCALPET Left-Handed Snor 9 daps 305.71 0.00 5410.79
S 28A11/2011 06A10/2017 LOCALPET Left-Handed Shor. O 30671 0.oo 541079
S 1312/2011 20/10/2011 LOCALPET Left-Handed Snor O 30571 0.00 5410.79
0
O
0
0O
0O
[
Print ] [ Graph ] [ Refresh ] [ Send To... ] [Manage Payments ] [ Chase Debt ]
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This window displays any outstanding payments, receipts and recurring entries that have
been entered into your Sage 50 Accounts software.

= To print a copy of the outstanding transactions, click Print.
= To view a graphical summary of the outstanding transactions, click Graph.
= To export the transaction list into Microsoft® Excel, click Send To.

= To switch to your Customers or Suppliers module chase windows, click Chase Debt
or Manage Payments, respectively.

Note for network users: If someone changes the accounts data from another PC on the
network, your cash flow will be out of date. To update your accounts data, click Refresh.

To return to the Bank window, click Close.
The Cash Flow window displays the following information:

Date Range Use this drop-down list to select a pre-defined period range:

= Next 7 Days

= Next 14 Days

= Next Month

= Next 2 Months

= Next 3 Months

If a user manually enters a date, the display will show Custom.
From By default, this box displays a date sixty days prior to the Sage

50 Accounts program date.

Forecast up to

Enter a date in this box. Entering a date in this box, will update
the list of outstanding transactions in the Cash Flow window.

By default, the date displayed in this box is today's date plus
seven days.

Change the date in this box to see how your cash flow changes
over time.

Note: The further into the future that you set this date, the less
accurate your forecast will be as it is only calculated using the
transactions that have already been posted into your Sage 50
Accounts software.

The Summary area of the window shows a summary of the transactions listed in the

window as follows:
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Book Balance for
Bank Account(s)

Displays the total starting balance for the selected bank
accounts.

Regular Payments

Displays the total for all regular payments, for the selected bank
accounts, from recurring bank payments, recurring journal
credits and recurring payments on account.

Forecast Payments

Displays the total value for all forecast payments, such as
purchase invoices, credit notes, and manual entries with a credit
value.

Regular Receipts

Displays the total value of all regular receipts, for the selected
bank accounts from recurring bank receipts, recurring sales
receipts on account, and recurring journal debits.

Forecast Receipts

Displays the total value of all forecasted receipts, such as sales
invoices, credit notes, and manual entries with a debit value.

Forecast Book
Balance for Period

Displays the closing value for the bank accounts that have been
selected for inclusion in the cash flow. This is calculated as:

Book balance for Bank Accounts + ((Regular Receipts +
Forecast Receipts) - (Regular Payments + Forecast Payments))

Within the Bank Accounts area of the Cash Flow window, select the bank accounts that
you want to include in your Cash Flow forecast by selecting the check box next to the bank

account name.

Bank Accounts

1200 Bank Current Account 4799.37 0.0o

1210 Bank Depozit Account 0.00 noa ] =
1220 Building Soci... 0.00 000 [

1230 Petty Cash 0.00 ooo[]

1235 Cazh Register 0.00 noa ]

1240 Compary Credit Card 0.00 n.o0 [

All of the bank accounts that have been set up in your Sage 50 Accounts software appear.

Note: If you have set up any foreign currency bank accounts, they will also appear here.
However, the values are displayed in the base currency that you assigned in Sage 50

Accounts.

The main area of the Cash Flow window displays five tabs: - All, Regular Payments,

Forecast Payments, Re

gular Receipts and Forecast Receipts.

In each tab, the following transaction details appear:
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Forecast

This column displays the date that the payment (or receipt) of the
transaction is expected to be made. By default, any sales
invoices will have a date based on the following calculation:

Invoice Date + Average Number of Days that it usually takes the
customer to pay.

All other transactions will have a default date that is set to the
transaction's due date.

Due

This column displays the date that this transaction was due. You
cannot change this date.

A/C Ref

This column displays the account reference that was entered on
the customer, supplier or nominal record.

Details

This column displays the transaction, depending on the type of
transaction.

Overdue

This column displays the number of days' difference between the
Program Date and the Due Date.

Disp?"
(Disputed)

This column displays a 'd"' alongside the transaction, if the
transaction has been marked as disputed.

Note: Any transaction that has been flagged as disputed will not
be included in the cash flow, but will be displayed in the list. To
include the disputed transaction, select the Include check box for
the transaction.

Inc?
(Include)

Select the check box to include the transaction in the cash flow.
If this check box is not selected, the transaction amount will not
be included in the running total column on the right of the cash
flow window - Balance for Day, or the cash flow summary.

Receipts

This displays the amount outstanding on the transaction.

Debit amounts are shown here for sales invoices, recurring bank
receipts, recurring journal debits and recurring customer receipts
on account.

Note: You can only change the amount in this column if the
transaction is a manual entry.
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Payments

This displays the amount outstanding on the transaction.

Credit amounts are shown for purchase invoices, recurring bank
payments, recurring supplier payments on account, recurring
journal credits.

Note: You can only change the amount in this column if the
transaction is a manual entry.

Balance for Day

The Balance for Day column displays the running total of the
forecast balance per forecast date. The last transaction for the
day will show the balance total.

This balance is calculated as:

Opening Balance for the day + total Debit Amount for day - total
Credit Amount for day

If this balance is less than zero, or is below the selected Bank
Account's minimum limit, the value is displayed in red.

Note: This column does not display any information if the
window is sorted by any other option than Forecast.

Manual entries in a cash flow

It is possible to enter a manual entry into the Cash Flow to account for any transactions that you
are expecting, but have not posted onto your Sage 50 Accounts system.

You may also choose to add a manual entry to see what would happen to the cash flow if an
unexpected cost occurred during that cash flow period.

To enter a manual entry into the cash flow window

1. From the Bank Accounts, Customers Chase Debt or Suppliers Manage Payments
windows, click Cash Flow.

The Cash Flow window appears. The window shows all selected outstanding transactions
for the selected bank accounts to the date specified in the Forecast up to box.

2. Place the cursor in the first vacant line of the list, in the A/C Ref Column - the date in the
Forecast and Due columns automatically defaults to the current program date.

3. Enter the following details in the row. Data in other columns cannot be edited:
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Forecast Enter the date when you expect to actually receive or make the
payment. Either enter the date directly into the column, or click the
button alongside the column to select the date from the pop-up

calendar.

A/C Ref Enter a reference code for the manual entry. This will allow you to
identify the transaction on any cash flow reports that you may choose
to run.

Details Enter a description of the entry that you want to add to the cash flow.

This allows you to recognise the transaction on the cash flow and the
cash flow reports.

Inc? Ensure that the check box in the Inc? column is checked so that the
entry is included in the cash flow. Deselect the check box to remove the
transaction from the cash flow.

Receipts/ Enter the amount of the payment or receipt in the appropriate column.

Payments ) , . .
For example, if you are recording a sale, enter the value in the Receipts

column.

4. Click Print to print a copy of the outstanding transactions. Click Graph to view a graphical
summary of the outstanding transactions. Click Send To... to export the transaction list
into Microsoft® Excel.
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